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In This Guide
Agilent has prepared this manual as a technical reference for the 5200/5300/5400 
Fragment Analyzer systems.

This document includes system overviews, installation and operational 
qualification procedures, analytical methods, maintenance procedures, software 
operation, troubleshooting guide, and instrument shutdown procedures. Additional 
information includes literature references, instrument specification and utility 
requirements, parts and supply lists, product specification sheets, and system 
warranty information.

This document is intended for use by technical personnel that are proficient with 
analytical instrumentation operation and upkeep. A certain level of training and 
expertise is assumed and fundamentals are not addressed herein. Procedures are 
presented in a step-by-step format using photos and screen captures. If questions 
remain after reviewing a given procedure, please do not hesitate to contact your 
corresponding Agilent Sales/Service Representative.

1 System Overview 

This chapter gives an instrument overview.

2 Safety 

This chapter provides additional information on safety.

3 Legal and Regulatory 

This chapter provides additional information on legal and regulatory aspects.

4 Fragment Analyzer Software – File Menu 

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the File menu.

5 Fragment Analyzer Software – Administration Menu 

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the Admin menu.
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6 Fragment Analyzer Software – Utilities Menu 

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the Utilities menu.

7 Fragment Analyzer Software – Help Menu 

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the Help menu.

8 Fragment Analyzer Software – Operation Tab 

This chapter describes the Fragment Analyzer software in more detail on the 
Operation tab.

9 Fragment Analyzer Software – Run Status Tab 

This chapter describes the Fragment Analyzer software in more detail on the Run 
Status tab.

10 Fragment Analyzer Capillary Array 

This chapter explains the essential operational parameters of the capillary array.

11 Fragment Analyzer – Sample Name Entry 

This chapter provides information on how to enter the sample names in the 
Fragment Analyzer software.

12 Fragment Analyzer – Automated Analysis 

This chapter explains the procedure for automated analysis using the Fragment 
Analyzer.

13 Maintenance and Troubleshooting 

This chapter provides additional information on part numbers, maintenance 
procedures, and system settings.
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About the System

The Fragment Analyzer system is a multiplexed capillary electrophoresis (CE) 
instrument for performing automated, high throughput separation and 
quantification of double stranded nucleic acids (DNA and/or RNA). Separation is 
achieved by applying an electric field through a narrow bore (50 µm i.d.) fused 
silica capillary array filled with various conductive gel matrices designed to sieve 
DNA/RNA molecules of a specific size range. When a high voltage is applied to 
the capillary array, injected DNA/RNA migrates through the gel matrix as a 
function of length or size, with smaller sized fragments eluting faster than larger 
sized fragments.

At a point toward the far end of the capillary array, detection of the separated 
DNA/RNA is achieved by fluorescence of a sensitive intercalating dye present in 
the separation gel matrix, which fluoresces when bound to double stranded DNA 
or RNA molecules. The Fragment Analyzer system utilizes a high intensity light 
emitting diode (LED) excitation light source that is focused across the capillary 
array detection window and imaged onto a sensitive, two-dimensional 
charge-coupled device (CCD) detector. By monitoring the relative fluorescence 
unit (RFU) intensity as a function of time during the CE separation, digital 
electropherograms representative of the DNA/RNA content of 12-, 48-, or 
96-samples are collected in a single experimental run.
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Intended use of the Fragment Analyzer System

The Fragment Analyzer System (M53XAA) separates nucleic acids by means of 
capillary electrophoresis.

The system is designed to detect:
• Fluorescently stained double-stranded DNA including genomic DNA and

cfDNA
• Fluorescently stained total RNA (Eukaryotic and Prokaryotic)

CAUTION

The Fragment Analyzer system is designed for professional use to exclusively 
run Agilent Fragment Analyzer reagent kits and specified consumables.

For Research Use Only. Not for use in diagnostic procedures.

Do not use this product in any manner not specified by the manufacturer. The 
protective features of this product may be impaired if it is used in a manner not 
specified in the operation instructions.

Unapproved, non-recommended or altered reagents
Altering any reagents and/or use of unapproved or non-recommended 
reagents may materially alter the performance of the instrument such that the 
instrument no longer performs to Agilent specifications. 
Any work performed by Agilent to bring the instrument back into compliance 
with Agilent specifications will be performed at the customer’s expense.

 Always use the recommended and approved reagents to ensure proper   
 instrument performance according to Agilent specifications.

 Do not use reagents that are altered, damaged or not properly labeled.

 Ensure correct handling, storage and disposal of reagents.
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Physical Specifications

Table 1 Physical specifications

* The given operating range is for the instrument itself. Many sample migration speeds will be significantly 
slowed at temperatures below 20° C

Type Specification

Weight 39.0 kg (86.0 lbs)

Dimensions (w×d×h) 101.6 × 61 × 86.4 cm (40.0 × 24.0 × 34 inches)

Line voltage 100 – 200 VAC

Line frequency 50 – 60 Hz (200 – 230 VAC; 50 – 60 Hz available)

Power consumption ~110 VA / 90 W

Ambient operating 
temperature*

15 – 25° C (59 – 77° F)

Operating humidity* < 80 % (non-condensing)

Safety standards IEC, EN, CSA, UL, Overvoltage category II, Pollution degree 2 for indoor use only

ISM classification ISM Group 1 Class A
According to CISPR 11

Sound pressure < 70 dB (A) According to ISO 7779, 1988/EN 27779/1991
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Installation

This chapter provides a basic overview of the Fragment Analyzer system 
hardware installation and operation. Figure 1 shows an external view of a fully 
configured Fragment Analyzer system, which has a compact footprint of 40” on 
the bench top with a weight of 86 lbs (39 kg).

Figure 1 Configured Fragment Analyzer system with computer workstation

Fragment Analyzer System installation should only be performed by licensed 
Agilent representatives and approved channel partners. Installations are not to be 
completed directly by customers.

Ensure the lab space meets the criteria specified in the Instrument Site 
Preparation Checklist (5200/5300 Site Prep Guide (D0029169) or 5400 Site Prep 
Guide (D0029173)). Spacing, environmental conditions, power consumption, and 
miscellaneous required operating supplies are included in this checklist.
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WARNING
Heavy weight
The instrument is heavy.

Avoid back strain and injury by following all precautions for lifting heavy 
objects.
Ensure that the load is as close to your body as possible.
Ensure that you can cope with the weight of your load.

If an instrument needs to be relocated to a new location, please contact your 
local support representatives for instrument-specific guidance.
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PC Management

The software is run using a PC with Microsoft Windows 10 or higher, with the 
following requirements (Table 1):

Table 2 Minimum computer requirements

NOTE
Use of non-Agilent PCs are permitted though they are "use at own risk". Desktop 
PCs are recommended, laptops should not be used.

Type Specification

Processor Intel i5 or above

SVGA Video Display Resolution 1280 x 1024 or 1280 x 800

Memory 8 Gigabytes

Available Storage Space 500 Gigabytes

USB Serial Ports 6 ports (2 instrument, keyboard, mouse)
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PC setup

CAUTION
Wrong settings
The recommended PC to use comes bundled with the Fragment Analyzer.
If the Fragment Analyzer computer settings do not match those below 
communication issues to the instrument are possible, resulting in lost time and 
productivity.

Date and Time Settings
1 Go to Date and Time Settings > Set to Local Date & Time.
2 Go to Settings > Time & Language > Date & Time and turn off the option Adjust 

for daylight saving time automatically. 

USB Power Management Settings

1 Go to Device Manager > Universal Serial Bus Controllers > USB Root Hub 
(USB 3.0).

2 Right-click Properties > Power Management and deselect the Allow the 
computer to turn off this device to save power check box.

To ensure best operating conditions it is recommended to not have any other
applications open and running while using the data acquisition software.

 If a different PC is to be used or if any changes are made to the existing PC,
 check the following settings and enabled/disabled the PC settings to match   
the recommended setup.
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USB Power Management Settings

1 Go to Device Manager > Universal Serial Bus Controllers > Intel® USB 3.1 
extensible Host Controller.

2 Right-click Properties > Power Management and deselect the Allow the 
computer to turn off this device to save power check box

3 Go to Settings > System > Power & Sleep and select Never.
4 Go to Additional Power Setting and select High Performance.
5 Go to Settings > System > Notification and set all to Off.
6 Go to Settings > Gaming and turn off the Xbox Game Bar:

a Deselect Open Xbox Game Bar.
b Set Game Mode to Off.

7 Go to Settings > Privacy and set all to Off.
8 Go to Settings > Updates and set all to Off.
9 Go to Security > Windows Security > Virus & Threat Protection Settings and set 

all to Off.
10 Go to Settings > Windows Update > and select Check Now/Refresh to update to 

the latest available version.
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About the Software

The Fragment Analyzer system employs proprietary software for operation and 
data analysis.

This software is preloaded on the instrument and checked prior to shipment as 
part of the instrument qualification.

No licenses are required for this software and the latest version installer is made 
freely available on the Agilent website.

https://www.agilent.com
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Software Installation

To install the Fragment Analyzer software:
1 Navigate to the Fragment Analyzer installer on the Agilent website. Download 

the installer and double-click on setup.exe.
2 Follow the setup instructions provided by the installation wizard. The default 

installation directory is C:\Agilent Technologies\Fragment Analyzer.
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Fragment Analyzer System Connections

The back of the Fragment Analyzer system contains the communications panel 
where necessary connections are made to the instrument computer and 
electrical outlet for operation (Figure 2 and Figure 3).

The use of a double-conversion surge protection or uninterrupted power supply 
(UPS) device is highly recommended. Contact the corresponding Agilent 
sales/service representative for specific recommended models.

A minimum of three standard electrical wall outlets should be available to 
connect the instrument, computer, and accessories, although a power strip can 
be used in place of separate wall outlets if needed.

Each connection is labeled on the PC. The various connections between the 
system and the Fragment Analyzer system are summarized below:
• Connection Figure 2: Rear of PC

• Two USB connections to Fragment Analyzer system

The order/location of these cables can be in any configuration though we
do recommend to connect these cables into non-adjacent ports as a
preventative measure against communication drops.

• Power cord to grounded electrical outlet
• Connection to monitor, keyboard, mouse, etc.
• (Optional) ethernet cable

Connection to monitor, keyboard, mouse, etc.
• Connection Figure 3: From the Fragment Analyzer system

• Two USB cables to PC USB
• Power cord to grounded electrical outlet

NOTE
A wired mouse and keyboard can lead to connection issues. It is always 
recommended to use a wireless mouse and keyboard like the ones that come 
with the instrument bundle.

NOTE
When power-cycling the instrument and PC, disconnect the instrument USB 
cables from the PC as several boards/components receive power through these 
cables.
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Figure 2 Rear of PC showing all electrical connections

Figure 3 Rear of instrument showing all electrical connections

Labeled USB Connections

Computer Monitor Connection

AC Power Connection

Labeled USB Cables

Fuse Mount

Power Switch

AC Power Connection

A B
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Fragment Analyzer External Cabinet

There are three primary points of access to the inside of the Fragment Analyzer 
system: the top compartment, the side compartment access door and the 
drawers (six total) (Figure 4).

Figure 4 Entry points of the Fragment Analyzer system

Top Compartments:
Capillary Array
Optics

Drawers

Side Compartments:
Pump
Reagent Bottles
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Top Compartment

Figure 5 Top compartment

CAUTION
Interrupted operation
Opening the top compartment while the HV ON light is illuminated will abort the 
active operation, stop the method queue, and result in data loss.

Ensure that the light is on for any action involving the high voltage power 
supply. This includes voltage injections and separations.

The top compartment provides access to the optical detection platform and a 
12-, 48-, or 96-capillary array cartridge. A non-accessible compartment on the 
back of the instrument contains the high voltage power supply and electronics 
that are connected to the array cartridge and safety interlock system. The safety 
interlock system shuts off the high voltage in case this door is opened while the 
instrument is running.

The 12-, 48-, or 96-Capillary Array Cartridge is a replaceable, modular component 
of the Fragment Analyzer system. The user can easily exchange the capillary 
array cartridge (for more information, refer to Chapter 6, “Fragment Analyzer 
Software – Utilities Menu”). 

NOTE
The 5200 Fragment Analyzer is only compatible with 12-capillary array 
cartridges. The 5300 Fragment Analyzer can be compatible with 48 and 
96-capillary array cartridges.
The 5400 Fragment Analyzer is only compatible with 96-capillary array 
cartridges.

HV ON indicator light
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Figure 6 Fragment Analyzer main unit top compartment opened

WARNING
High voltage
The Fragment Analyzer contains a high voltage supply cable. It is marked by a 
hazardous voltage sticker. This cable sends electricity to the capillaries during 
any actions that use high voltage (pre-run, injections, separation). If the top 
compartment is not shut properly, the high voltage power supply will not be 
delivering any power to the cable.

Ensure that the cover is properly shut before operating the instrument.

High Voltage Supply Cable

Light Guide

Capillary Outlet Connection

Reservoir

Reservoir Vent Valve

Capillary Array
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Side Compartment

The side compartment allows access to the high pressure pump, syringe, waste 
bottle, conditioning solution, and gel solutions (gel 1 and gel 2).

The high pressure syringe pumping system provides automated flushing and 
filling of the capillary array with conditioning solution and separation gel between 
experimental CE runs, pressurizing the capillaries up to 280 psi.

The system design enables vacuum injection (hydrodynamic injection) of 
samples in addition to traditional electrokinetic (voltage) sample injection, which 
is a feature unique to the Fragment Analyzer platform and advantageous when 
working with samples containing high salt matrices.

Two different solutions are fed to and pumped through the capillary array during 
routine operation:
• Capillary conditioning solution
• Separation gel (gel 1 or gel 2)

The appropriate solution is selected for pumping by way of a 6-way distribution 
valve.

The system also contains a waste bottle, which collects solutions pumped via 
the waste line from the capillary array reservoir during the filling process.

WARNING
Toxic, flammable and hazardous solvents, samples and reagents
The handling of solvents, samples and reagents can hold health and safety
risks.

When working with these substances observe appropriate safety 
procedures (for example by wearing goggles, safety gloves and protective 
clothing) as described in the material handling and safety data sheet 
supplied by the vendor, and follow good laboratory practice.
The volume of substances should be reduced to the minimum required for 
the analysis.
Do not operate the instrument in an explosive atmosphere.
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Figure 7 Side Door Compartment

The six fluid line connections inside the Fragment Analyzer system as they 
connect to the 6-way multivalve: 
• Line to waste bottle – valve position A
• Reservoir filling line – valve position B
• Conditioning line – valve position C
• Gel 1 line – valve position D
• Gel 2 line – valve position E
• F-port line – valve position F

Gel 2

Waste

6-Way Distribution Valve

Conditioning
Solution

Gel 1
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Drawers

The Fragment Analyzer front-panel drawers provide an external interface for 
loading buffer, marker, and sample 96-well plates or PCR tubes into the system.
• Drawer B (top drawer): This location is used for the inlet buffer tray used

during the CE separation. This drawer position is also used for capillary
storage solution in the 12-capillary instrument.

• Drawer W (second drawer from top): This location is utilized for a waste tray
when the capillary array is flushed.

• Drawer M (third drawer from top): This location is used for loading the marker
tray or rinse buffer.

• Drawer 1 (fourth drawer from top): This location is utilized for sample plate
number 1.

• Drawer 2 (fifth drawer from top): This location is utilized for sample plate
number 2.

• Drawer 3 (sixth drawer from top): This location is utilized for sample plate
number 3. It is also the default location for a 96-well plate containing capillary
storage solution.

NOTE
The marker drawer (drawer M) is used for a separate marker injection when 
running a qualitative kit. It is used for a TE rinse step (capillary tip dip) for any of 
the quantitative kits.
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Drawer status

Figure 8 Instrument drawer positions

Status Description
Drawers B and W are interlocked When either of the top two drawers are open, the high-voltage 

(for electrophoresis) will automatically shut off. This voltage 
should only be enabled during a pre-run voltage check, voltage 
injection steps, and the separation itself. This will be indicated 
by the illumination of a LED in the upper right corner of the top 
compartment hood.

Drawers M, 1, 2, and 3 are not interlocked Sample trays can be exchanged while the instrument is in 
operation.

Drawer B: Buffer

Drawer W: Waste

Drawer M: Marker/Rinse

Drawer 1: Sample

Drawer 2: Sample

Drawer 3: Sample
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Fragment Analyzer Loading and Orientation of 
96-Well Plates

The Fragment Analyzer system is a multiplexed CE system containing a 12-, 48-, 
or 96-capillary array, which is designed to interface directly with a single row or 
entire plate of a standard 96-well plate footprint. Each capillary of the array 
corresponds to a specific well for a given row in the 96-well sample plate. For 
example: The capillary array orientation is indexed such that capillary #1 
corresponds to well A1 and capillary #12 = A12.

Well A1 of the 96-well plate should always be oriented to the back left location of 
the instrument drawer to ensure that the sample well location is correctly 
assigned and reported in the software.

Figure 9 Proper orientation when loading 96-well marker and sample plates for a 12-capillary system

Each drawer location houses a tray carrier containing alignment pins for ensuring 
proper alignment of the 96-well plate when placed against the capillary array.

The Fragment Analyzer system has been designed to operate using specific 
dimensions and styles of plates. 

Plates with similar dimensions may be used, but capillary damage may occur 
with the use of poor-quality PCR plates.

For a list of compatible PCR plates please refer to “Compatible Plates and Tubes 
for Fragment Analyzer Systems” on page 132. 

Well A1

Well H12
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Fragment Analyzer Loading Samples

The Fragment Analyzer system requires a minimum volume of 20 µL/well in the 
sample plate for proper injection.

When preparing lower/upper DNA marker plates for repeated use, a volume of 
30 µL/well with a 20 µL mineral oil overlay is recommended.

NOTE
If you use the mineral oil dropper bottle supplied with some Fragment Analyzer 
reagent kits, one drop from the bottle is adequate.

Ensure the sample has been adequately mixed with the diluent marker or dilution 
buffer before loading on the instrument.

Vortexing sample is the best way to ensure adequate mixing before analysis.

Check the wells of the sample plate/s after pipetting to ensure that there are no 
air bubbles trapped in the bottom of the wells. The presence of trapped air 
bubbles can lead to injection failures. 

Air bubbles can be removed from the plates by introducing a brief centrifugation 
step prior to placing the plates into the tray carrier.

Individual recommendations are given in each kit guide for reference.
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General Safety Guide

The general safety guide can be found on https://www.agilent.com through the 
general search function.

The general safety guide contains all symbols, warnings, etc., as well as any 
information on how to locate the Declarations of Conformity. 
The table below is a relisting of all Fragment Analyzer Systems symbols from the 
general safety guide.
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Safety Symbols

Table 3 Symbols

Symbol Location Description

Top Compartment Indicates hazardous voltages.

Syringe Pump Indicates a pinching hazard.

Reservoir Indicates frame or chassis terminal, which is bonded to conductive parts of an 
equipment for safety purposes.

Serial Number Tag

Top Compartment

Adhere to specific voltages indicated.

instrument is equipped with high voltage interlocks for user safety. For proper 
operation top cover should be closed. Interlocks should never be defeated.

Inside Reagent Door Warns of the use of and exposure to hazardous and/or corrosive chemicals. 
Consult reagent kit guides and SDS sheets for listing of precautions and handling 
information.

Serial Number Tag Confirms that a manufactured product complies with all applicable European 
Community directives. The European Declaration of Conformity is available 
at: http://regulations.corporate.agilent.com/DoC/search.htm

Power Supply Switch Power symbol indicates ON.

Power Supply Switch Power symbol indicates OFF. The apparatus is not completely disconnected from 
the MAINS when the power switch is in the OFF position.
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General Safety Information

The following general safety precautions must be observed during all phases of 
operation, service, and repair of this instrument. Failure to comply with these 
precautions or with specific warnings elsewhere in this manual violates safety 
standards of design, manufacture, and intended use of the instrument. Agilent 
Technologies assumes no liability for the customer’s failure to comply with these 
requirements.

WARNING
Heavy weight
The instrument is heavy.

Avoid back strain or injury by following all precautions for lifting heavy 
objects.
Ensure that the load is as close to your body as possible.
Ensure that you can cope with the weight of your load.

WARNING
Unintended use of power cords
Using power cords for unintended purposes can lead to personal injury or 
damage of electronic equipment.

Never use a power cord other than the one that Agilent shipped with this 
instrument.
Never use the power cords that Agilent Technologies supplies with this 
instrument for any other equipment.
Never use cables other than the ones supplied by Agilent Technologies to 
ensure proper functionality and compliance with safety or EMC regulations.

WARNING
Reagents
Toxic and hazardous reagents and flammable liquids. The handling of reagents 
can hold health risks. 

When working with reagents observe appropriate safety procedures (for 
example: goggles, safety gloves and protective clothing) as described in the 
safety data sheet supplied for the reagent kits, especially when toxic or 
hazardous solvents and flammable liquids are used.
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Sound Emission

Manufacturer’s Declaration

This statement is provided to comply with the requirements of the German 
Sound Emission Directive of 18 January 1991.

This product has a sound pressure emission (at the operator position) <70 dB.
• Sound Pressure Lp <70 dB (A)
• At Operator Position
• Normal Operation
• According to ISO 7779:1988/EN 27779/1991 (Type Test)

NOTE
:This is an ISM Group 1 Class A product intended for use in industrial 
environments. In a domestic environment, this product may cause radio 
interference, in which case the user may be required to take adequate measures.
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Waste Electrical and Electronic Equipment 
(WEEE) Directive

This product complies with the European WEEE Directive marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

NOTE
Do not dispose of in domestic household waste.
To return unwanted products, contact your local Agilent office, or see 
https://www.agilent.com for more information.
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4 Fragment Analyzer Software – File Menu

Opening the Fragment Analyzer Software 34

Main Screen Toolbar 35

File Menu 36
File Manager 36
Exit 39

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the File menu.
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Opening the Fragment Analyzer Software 

1 To open to the software, select the Fragment Analyzer software icon.

Figure 10 Fragment Analyzer icon

The main screen opens.

Figure 11 Fragment Analyzer software main screen window (example shows the software for a 5300 
Fragment Analyzer instrument)

NOTE
Unless you download and set up the standalone Agilent Administration software, 
there will not be a login prompt for the Fragment Analyzer controller software 
with version 5.0 and later.

More information about the different permissions and access to the software is 
available in the Agilent Administration software manual.
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Main Screen Toolbar

The Main Screen Toolbar is located at the top of the Fragment Analyzer main 
screen as seen in Figure 11.
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File Menu

Figure 12 File menu commands

File Manager

The file manager function allows electropherogram data to be examined within 
the Fragment Analyzer program environment.

Files are normally analyzed using the ProSize Data Analysis Software, which is 
covered in the ProSize software User Manual.

The File Manager also enables one to correct the capillary alignment for an 
individual data file.

Selecting the File Manager function will open a window allowing the user to 
navigate to a data file. Once a file is selected, the file manager screen will appear 
(Figure 13).
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Figure 13 File manager window

The File functions of the file manager screen are reviewed in Table 4.
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Table 4 File manager – file functions.

The Current, Method Summary, and Sample Info toolbar functions are discussed 
in Table 3.

Table 5 File manager toolbar options.

Once the data file is opened in file manager the data can be viewed in groups of 
12 (by row) when the Group tab is selected. A page selection is located at the 
bottom of the screen allowing for navigation of all rows in a plate (assuming 48- 
or 96-capillary array data is chosen). 

To view a single electropherogram at a time, either double left-click on the 
desired well or select the Single tab. A page and well selection is located at the 
bottom of the screen allowing for navigation of all rows and wells in the plate. 

Electropherogram data can be panned, zoomed, or zoomed out by right-clicking 
on the chart and selecting the function of interest.

Field Description

Open Opens a Windows dialogue box to navigate to desired data file.

Cap. Alignment Allows the user to view and manipulate the capillary alignment for the data file 
opened only. Capillary alignment from a file is discussed in the capillary alignment 
chapter.

Merge Files Available for users running an entire 96 well tray on a system with less than 96 
capillaries. This will generate: file with a single sample name, a single raw data file, 
a single method file.

Print Allows the user to print twelve electropherograms to a page.

Exit Closes the file manager window.

Field Description

Current Selecting current allows user to view the current of the separation during the 
analysis.

Method Summary Selecting the method summary option shows a summary of the method that was 
used for the separation.

Sample Information Selecting the sample Information option shows the user the sample names input 
for the separation file.

View Array Window Selecting the View Array Window option shows the camera image of the capillary 
array window.
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Exit

The Exit command closes the Fragment Analyzer program. Alternatively, the user 
can exit the program by selecting the red X on the top right corner of the main 
screen.
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5 Fragment Analyzer Software – Administration 
Menu

Administration Menu 41
Configuration 42
Results Report Setup 45
Event Report 46
Error Report 48

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the Administration menu.
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Administration Menu

Figure 14 Admin menu commands
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Configuration

Selecting the Configuration option from the drop-down menu opens the 
Configuration Settings window. You can modify the Device Settings and Bottle 
Volumes for the system here.

The Device Settings tab allows modification of the device settings (Figure 15).

Update the settings whenever you install a new capillary array cartridge.

Update the capillary array serial number field whenever you install a new capillary 
array cartridge.

Ensure that the instrument serial number field accurately reflects the stickered 
number on the physical instrument.

A summary of the configuration options in the Device Settings tab is provided in 
the Table 6.

Figure 15 Configuration – Device Settings tab
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Configuration Options

Table 6 Configuration – Device Settings tab functions

Parameter Description

Number of Capillaries Values: 12, 48, or 96
Note: Selecting 12- or 48- when a 96-capillary array is installed may 
cause hardware issues and ruin the array.

Capillary Length 22, 33, or 55
Note: Refers to the effective length of the capillaries in use. 
Selecting a capillary length will force the system to use those 
methods only. 22 cm effective capillaries are only available with 
12-capillary instruments.

Capillary Array Serial Number The format must be xxxxxx-xx-xxxx.

Buffer Tray Default selection is locked.

Storage Solution Tray Allows for the selection of tray and row for the storage solution 
tray.

Set Tray Name to Folder Prefix Sets the tray name to the folder prefix used when loading sample 
trays.

Reset Tray Info when Queuing Resets tray info for each new tray that is loaded.

Automated report application Allows for changing the file path used for the automated report 
application.

ProSize data analysis software path Allows for changing the file path used to open the ProSize data 
analysis software. 

Save Saves the chosen settings.

Reload Reloads the previously saved settings.
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The Bottle Volumes tab allows modification of the reagent bottle volumes 
(Figure 16).

The gel 1, gel 2, conditioning, and waste bottles can be set from 50 mL to 
5000 mL by entering the appropriate volumes. These settings depend on the 
types of containers used in the system. For example, most 12-capillary systems 
use 50 mL centrifuge tubes for gel 1 and gel 2, with a 250 mL centrifuge for the 
conditioning solution. 96-capillary systems may use 250 mL for gel 1, 250 mL for 
conditioning, and 50 mL for gel 2. Larger volumes may be used if the system is 
configured with larger containers.

Figure 16 Configuration – Bottle Volumes tab
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Results Report Setup

The option Results report setup opens the Automated Report Settings window 
(Figure 17).

The settings allows the administrator:
• to enable auto processing, and 
• to select the types of reports generated upon the act of auto processing.

For more information about auto-processing, refer to Chapter 12, “Fragment 
Analyzer – Automated Analysis”.

Figure 17 The Results Report Setup screen

Checking the Enable Automatic Reporting turns the auto-processing function 
on/off. When the auto-processing function is selected, the program will call a 
ProSize executable, process the data, and then export the desired results (PDF, 
standard peak table, etc.). For a complete description of each of these data types, 
refer to the ProSize data analysis software manual, or to Chapter 12, “Fragment 
Analyzer – Automated Analysis” which gives a detailed description of auto 
processing.

NOTE
In order for auto-processing to work correctly, the name of the Fragment 
Analyzer method must exactly match the name of the ProSize configuration file. 
For more details, please refer to Chapter 12, “Fragment Analyzer – Automated 
Analysis”.
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Event Report

The command Event Report provides a tabular report of the audit trail of the 
events that have occurred in the Fragment Analyzer program. 

Selecting the command Event Report from the Administration menu opens the 
Select Date Range window where the user can Use all dates or Use selected date 
range (Figure 18).

Figure 18 Event Report popup window

Users with both administrator and user privileges can view the Event Report.

The event report contains the following information for each event log item:
• User name – User who was logged in.
• Computer name – Network name of the computer where the event occurred.
• Event date
• Event code action
• Description

After selecting the appropriate date range in the Select Date Range window and 
selecting OK, an Event Report is generated (Figure 19).
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Figure 19 Event Report example

The icons along the top of the Event Report follow standard Windows function 
nomenclature and are summarized in Table 7.
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Table 7 Event Report icons and descriptions

Error Report

The command Error Report is used for advanced troubleshooting. 

Selecting the command Error Report from the Administration menu opens the 
Select Date Range window where the user can Use all dates or Use selected date 
range (Figure 20).

Figure 20 Error Report popup window

Icon Description

Page Selection

Back to Parent Report

Stop Rendering (i.e. Stop Report Generation)

Refresh

Print

Print Layout

Page Setup

Save

Zoom

Search
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The error report captures the following information:
• Software exceptions and Hardware errors detectable by the software
• User Name – The user who was logged in when the error occurred
• Computer Name – Network name of the computer where the error occurred
• Event Date
• Error Code
• Description

After selecting the appropriate date range in the Select Date Range window and 
selecting OK an Error Report is generated (Figure 21).

The icons along the top of the report follow standard Windows function 
nomenclature and are summarized in Table 7.

Figure 21 Error Report example
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6 Fragment Analyzer Software – Utilities Menu

Utilities menu 51
Capillary Alignment 52
Hardware Testing Screen 59
Prime 61
Solution Levels 62
Clean Reservoir Vent Valve 63
Results Dashboard 64

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the Utilities menu.
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Utilities menu

Figure 22 Utilities menu commands
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Capillary Alignment

The menu command Capillary alignment is required when a new capillary array is 
installed. It may also be performed to address issues as part of a troubleshooting 
exercise. 

There are two ways to perform a capillary alignment, though Method A is 
considered the most accurate. Method B can be the quickest: 

A) Alignment from a file – best used when installing new 96-capillary array or 
fine-tuning an alignment without dye.

B) Alignment without a file (12-capillary and 48-capillary only)

The methods discussed in this chapter will first be illustrated with images from a 
12-capillary array. Images from a 96-capillary array will be discussed at the end 
of this chapter.

All of the method steps outlined for performing capillary alignments will be the 
same for a 96-capillary array unless otherwise noted.
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Method A – Capillary Alignment from a File

1 Select Capillary Alignment from the Utilities drop-down window.

The Capillary Alignment window opens (see Figure 23).

Figure 23 Real time capillary alignment popup window (example shows 12-capillaries)

2 If the capillary window needs to be redrawn, refer to steps 2 – 6 of the Method 
B procedure later in this document.

NOTE
If a window is already drawn as the example shows, it will only need to be 
redrawn upon request by Agilent support or if some of the physical capillaries are 
not captured in the viewing window. We always recommend drawing this viewing 
window as wide as possible as shown in Method B.

NOTE
Skip to step 5 if the window does not need to be changed and a run has already 
completed with the currently installed capillary array.

3 Once a window has been drawn, proceed to raise the red horizontal line above 
the baseline noise and click Align.
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4 Click Auto Space to ensure all blue vertical lines are evenly spaced between 
the first and last capillary peak signals.

NOTE
It is normal for the blue vertical lines to not match with the capillary peaks at this 
step. The Auto Space function just serves to ensure all vertical lines have a unique 
X-coordinate. If any of these lines have the same Cap Position in the table in the 
upper right, an error message will appear when you attempt to save.

5 Click Save, which will close the capillary alignment screen. Perform a test 
separation with blank solution or diluent marker in each well. The run needs a 
peak to show up in each capillary. 

This file will be used for the alignment.
6 From the top menu bar of the Capillary Alignment window, select Read raw. 
7 Navigate to the raw file saved location using the Windows prompts. 

The default saved location of raw data is: 
C:/Agilent Technologies/Data/(Date: YYYY MM DD)/(Time: XXH XXM). 

8 Select the latest raw file (i.e., the last run file).

The Align from File window will open (Figure 24 shows an example for a 
12-capillary and Figure 25 for a 96-capillary) allows you to align the capillaries 
from the selected run file. The toolbar of the Align from File windows is 
described in Table 8.

Figure 24 Align from file popup window for 12-capillary system

Yellow boxes
denote capillary
location

Baseline

Capillary pixel
locations
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Figure 25 Align from file popup window for 96-capillary system

Table 8 Align from file toolbar functions

9 Left click on the red baseline and drag it upwards off the bottom of the graph 
but not above the top of capillary peaks, as shown in Figure 24 and Figure 25.

Yellow boxes
denote capillary
location

Baseline

Capillary pixel
locations

Icon Description

Opens a new file.

Accepts changes to the file (i.e., capillary locations).

Cancels any actions and closes the file.

Locates the original capillary positions used when the selected file ran.

Locates the capillaries based on peak positions in the selected open file.
Note: Move the red baseline up so that only the peaks of interest are integrated 
and not noise from the baseline.
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10 Select Locate caps from the toolbar of the Align from file window.

The capillary peaks are located and a yellow box is placed at the apex of the 
selected capillaries denoting the capillary pixel location. 

The bottom left corner of the window states the number of capillaries found. 
This should be 12, 48, or 96 depending on the configuration of the instrument 
and the type of array in use.

If necessary, adjust the capillary positions:
• To manually adjust a capillary position, left-click on the white line showing 

the capillary position and drag it left or right to the desired location. 
• To zoom in for desired resolution, right-click and select Zoom (and drag the 

appropriate area). 
• Should the number of capillaries be off due to too many or too few capillary 

positions chosen, adjust the red baseline and repeat the steps above.
• To insert or delete a capillary position, right-click on the black area of the 

graph or the capillary pixel location table to the right of the graph.
11 Once the correct number of capillaries are located, select OK from the Align 

from File toolbar. This will save changes and close the current window 
returning you to the live Capillary Alignment window. The blue vertical lines 
should now match up with each capillary peak location.

12 Select Save from the Capillary Alignment window. 

From this point forward the instrument will use these saved pixel locations for 
all future runs.

Method B – Capillary Alignment without a file

NOTE
A capillary alignment without a file can only be performed for a 12-capillary or 
48-capillary array. The 96-capillary array does not have enough physical space 
between capillaries to reliably perform this alignment procedure in the software.

1 Select Capillary Alignment from the Utilities drop-down menu. 

The real time view Capillary Alignment window opens (see Figure 23). 
2 Right-click on the blue display area and select Reset All to reset the camera 

array window. 
3 Adjust the contrast slide bar to the left to brighten the display (Figure 26).
4 Draw a box around the capillary array display area. Left-click and drag the 

appropriate area. (Figure 26).
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NOTE
Avoid the Top Red CCD Camera Reference Area and the Capillary Alignment 
References.

Figure 26 Capillary alignment display – window reset

5 After the box is drawn, right-click and select Set Camera Window.
6 Adjust the height to 14.

Table 9 Capillary alignment display menu options

Box drawn by
left-clicking
and dragging

Capillary alignment
references

Contrast slider

CCD camera
reference

Icon Description

Aligns cursors to peaks.

Saves changes to the alignment and exits the window.

Cancels any actions and closes the file.

Auto locates the capillary positions based off the first capillary position. Positions will 
need manual adjustment.

Opens the Align from File window allowing the user to complete the capillary 
alignment using a previously run file.
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7 Click and drag the red baseline seen in Figure 26 until a red triangle is 
observed on each capillary peak. This triangle determines where the blue 
vertical lines will be assigned in the next step. It is important to ensure this red 
line is above the baseline.

8 Select Align from the menu of the top capillary alignment display area. A blue 
vertical line will be placed through the center of each capillary. If the blue lines 
are not in the exact center of each peak, adjust the lines by left-clicking and 
dragging to the desired location.

9 Select Align every time the red baseline is moved. This ensures that the 
instrument has selected the peak for integration and places the blue vertical 
alignment line in the middle of each peak (corresponding to where the red 
dots are present).

NOTE
Every time you select Align, it will shift the blue vertical lines to the first set of 
peaks where the red triangles are present. For example: If the software is looking 
for 12 capillaries, it will place 12 vertical lines on the alignment screen where the 
first 12 red triangles are present from the left-hand side of the screen.

10 Select Save from the menu at the top of the Capillary Alignment window to 
save the current capillary locations and close the window.
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Hardware Testing Screen

The command Hardware Testing Screen is used for troubleshooting the 
instrument.

Selecting the Hardware Testing Screen command from the Utilities menu opens 
the Hardware Testing Screen (Figure 27). 

Figure 27 Hardware Testing Screen

An overview of the functions available in the Hardware Testing Screen is listed in 
Table 10.
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Table 10 Functions of the Hardware Testing Screen

Function Description

Valve > Waste Activates (toggles) the valve open (open circle) or closed (dark circle).

Valve > Reservoir Vent Activates (toggles) the valve open (open circle) or closed (dark circle).

Stage > Move Move tray to the selected position. 

Stage > Reset Stage Allows the user to tell the software that the stage is in the park location 
(forces the Holding number to '0'). This does not move the physical stage. 
Should only be used if the digital and physical stage positions do not 
match up – can be a user-generated error if a drawer is opened before the 
instrument has registered that a plate and adapter has returned to its 
corresponding drawer location.

Bottle Levels Gives a visual indication (simulation based on calculated usage) of the 
amount of reagents available in the system.
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Prime

The Prime command allows the user to prime any of the three available reagent 
bottle lines. This is useful when a user wants to purge a line containing an old gel 
or fluid with a new gel or fluid (should a new solution be added to the instrument).     
For example, if a user is switching between RNA gel and NGS gel, a gel prime can 
be used to purge of the old fluid prior to beginning a run. Another reason for 
priming is to remove air bubbles that may be found in the reagent lines after 
extended periods of sitting idle.

Selecting the Prime command from the Utilities menu opens the Prime window 
(Figure 28). The prime functions are discussed in Table 11.

Figure 28 Prime window

Table 11 Functions of the Prime window

NOTE
A prime function does not involve the reservoir/capillaries. It is simply a single 
2.5 mL syringe pull from the chosen liquid line pushed directly into the waste line.

Function Description

Fluid selected Allows the user to select which reagent line to prime.

Cycles Refers to number of cycles (1 – 10) of the syringe to complete. 1 cycle is generally 
sufficient.

Fill rate Allows the user to adjust the fill rate up and down 0 – 1000, the default setting is 
300 uL/s. 

Empty rate Allows the user to adjust the fill rate up and down 0 – 1000, the default setting is 
300 uL/s.
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Solution Levels

The command Solution levels allows the user to adjust the volumes added to the 
reagent bottles and adjust the waste bottle level when emptied. 

The Fragment Analyzer software tracks the solution levels as the instrument is 
used. This ensures that the instrument has enough fluids for all of the planned 
runs. 

If the solution levels are low, the program will issue a warning and ask the user to 
adjust the Solution Levels before it can proceed with a separation.

Selecting the Solution levels command from the Utilities menu opens the Check 
Solution Volumes window (Figure 29).

Figure 29 Check Solutions Volumes window

1 When solutions are re-filled, open this window and enter the correct solution 
levels (mL) for each container:
• Use the up and down arrows or type the solution level in each entry field to 

adjust solution levels.
• To save the changes to solution levels, select OK.

For the program to run correctly (i.e., to issue the correct warning), it is important 
that the solution levels be entered into the program each time that new solutions 
are placed onto the instrument.
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Clean Reservoir Vent Valve

The command Clean reservoir vent valve allows the user to clean the reservoir 
vent valve manually.

Selecting this command from the Utilities menu opens the reservoir vent valve 
and the waste valve and displays the Clean Reservoir Vent Valve window 
(Figure 30).

Figure 30 Clean reservoir vent valve screen

Follow the steps outlined in Figure 30 to clean the reservoir vent valve. Should 
you have an older system without the reservoir vent valve luer lock fitting and 
syringe please contact your Agilent Sales Representative for information on how 
to acquire them. 
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Results Dashboard

The command Results dashboard allows the user to quickly view the status of 
auto-processed data. 

Figure 31 shows an example in the Results Dashboard window. 

Figure 31 Results dashboard output

For more information about the Results dashboard and the window toolbar, refer 
to Chapter 12, “Fragment Analyzer – Automated Analysis”.
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7 Fragment Analyzer Software – Help Menu

Help Menu 66
User Manual 66
About 66
About Firmware 66

This chapter describes the Fragment Analyzer software in more detail on the 
commands of the Help menu.



7 Fragment Analyzer Software – Help Menu
Help Menu

5200, 5300, and 5400 Fragment Analyzer System Manual 66

Help Menu

Figure 32 Help menu commands

User Manual

Navigating to the command Users manual will provide a link to the full user 
manual in PDF form.

About

The About command opens an About Fragment Analyzer window displaying the 
version number of software, hardware serial number and copyright information.

About Firmware

The About firmware command opens a window displaying the version numbers 
of the firmware present on the High voltage board, Pump control board, Pressure 
board, and stage motion control board.
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8 Fragment Analyzer Software – Operation Tab

Operation Tab Overview 68
Hotel Position Icons 69
Tray Selection and Sample ID 70
Adding Methods to the Queue 72
Method Queue 79

Permissible Characters 82

This chapter describes the Fragment Analyzer software in more detail on the 
Operation tab.
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Operation Tab Overview

Figure 33 Fragment Analyzer main screen
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Hotel Position Icons

There are three hotel positioning icons located at the top of the Operation tab, as 
seen in Figure 33. The icons and their function are discussed in Table 12.

Table 12 Hotel position icon functions

Icon Description

This command is used to place the existing tray being held by the stage robot back 
into its respective drawer and move the stage platform to the bottom of the 
instrument.

This command is used to pick up the buffer tray from the buffer drawer and move it up 
against the capillary array.

This command is used to place the existing tray being held by the stage robot back 
into its respective drawer and then pick up the storage solution tray to move it up 
against the capillary array.
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Tray Selection and Sample ID

Select the sample tray to be used from either the Sample Tray drop-down list or 
the colored tab tray selection, depending which configuration is set (Figure 34).

NOTE
The configuration can be set by selecting the  icon located in the upper right 
corner of the window shown in Figure 34.

Configure the Visual Style of Tray Selection Window

Figure 34 Classic drop-down tray selection (left), and colored tab tray selection (right). 

1 In the tray window, select .

The Visual preferences dialog window opens (Figure 35).

Figure 35 Visual preferences dialog window.

2 Choose between the sample tray drop-down list or the colored tab tray 
selection as shown in Figure 34.

3 If you use the tab tray selection window, select  to change the color of 
each sample tray in the Color selection window.

A B
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4 To select a row from the 96-well plate depicted in the sample/sample tray 
window, left-click once in that row (Figure 34). To select a new row left-click 
on another row.

5 To clear a row selection, select . (Figure 34)

The Tray name dialog box allows you to input a name for the tray being run 
(Figure 34). Alternatively, select this dialog box and use a barcode scanner to 
import sample names for the plate being run (for more information, refer to 
Chapter 11, “Fragment Analyzer – Sample Name Entry”). 

Enter sample information in the Sample ID section of the main screen. (Figure 36)

For a 96-cap system, you must select each row individually to manually enter 
data (rows A-H). Sample names and information can also be saved or loaded 
using .txt or .csv files. These functions are discussed in Table 13.

Figure 36 Sample information editor

Table 13 Sample information editor functions

Item Description

Load From File Allows the ability to load sample names from a .txt or .csv based file. See 
chapter 10 for further information.

Save Tray Allows the user to save the information entered for an entire sample tray.

Save Selected Row Allows the user to save the information entered for the selected row of a 
sample tray.

Reset Row Resets the selected row to the default sample ID setting.

Tray Resets the entire sample tray to the default sample ID settings.
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Adding Methods to the Queue

The Fragment Analyzer software provides pre-loaded methods for both Capillary 
Array Conditioning and Separation Methods for each Analysis Kit offered by 
Agilent.

The Separation Run Controls shown in Figure 37 shows the settings to Run 
Selected Row (12-cap system only), Run Entire Tray, and Capillary Array – 
Conditioning. The Run Selected Group option is only available for a 5200 Fragment 
Analyzer (12-capillary) or 5300 Fragment Analyzer (48-capillary configuration). It 
will be hidden for both the 5300 Fragment Analyzer (96-capillary configuration) 
and the 5400 Fragment Analyzer.

Reagent Levels of the bottles are also shown.

Figure 37 Separation run controls
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Run Selected Group or Run Entire Tray – Edit Method

Selecting Edit method shows the method editor pop-up window for both 
separation methods Figure 38.

Figure 38 Separation method editor

The method editor window allows for customization of the run parameters for a 
CE separation.

Full conditioning, the gel-prime, and gel prime to buffer are not editable and 
cannot be disabled.

Selecting the check box next to the individual parameter can enable different 
steps and parameters. The individual parameters are discussed in Table 14.

Optimum capillary conditioning values are preloaded and defined for each 
method. Refer to each method Kit Guide of interest (for example, NGS, genomic 
DNA, etc.) for further definition of these values.
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Table 14 Method editor window functions.

The user can Load a new method, Save as a new method with a unique name, 
select Save to accept the changes and close the window, or Cancel to close the 
method editor window without accepting any changes made.

NOTE
When creating a new method with a unique name the user will need to make a 
corresponding Global Configuration in ProSize data analysis software with a 
matching name, please see the ProSize software user manual for more complete 
instructions.

Item Description

Gel selection Using the drop-down menu, the user can select the Gel 1 or the Gel 2 reagent 
bottle position.

Prerun A short pre-run is recommended to normalize and condition the gel inside the 
capillaries. 

Rinse The rinse option allows the user to dip the capillary tips into the selected position, 
which rinses both the capillary tips and electrodes between the pre-run and 
sample or marker injection. The tray position for sample rinse (row) and # dips 
(Dip count) can be altered as well.

Marker injection Marker injection is enabled when using the Qualitative Kits. The user has the 
option of a voltage or vacuum injection with selection of Voltage, Pressure, and 
Time parameters. On a 12-capillary unit, the user is able to select the Row to use 
for marker injection.

Rinse The rinse option allows the user to dip the capillary tips into the selected position, 
which rinses both the capillary tips and electrodes between marker injection and 
sample injection (or, if marker injection is not selected, this step is a second rinse 
between pre-run and sample injection). The tray position for sample rinse (row) 
and # dips (Dip count) can be altered as well.

Sample injection Selection of a Voltage, Pressure, and Time for the voltage or vacuum injection.

Separation Allows to enter the Voltage and Time of the CE separation. 
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Run Selected Group or Run Entire Tray – Add to Queue

Selecting the Add to queue option opens the Separation Setup window as seen in 
Figure 39. 

Figure 39 Separation Setup window

The settings of the Separation Setup window are discussed in Table 15.

Table 15 Separation setup window functions

Item Description

Method Methods can be selected from the drop-down menu. A user with 
administrator privileges can also select Edit to change any parameters of the 
method by opening the method editor window in Figure 38. User level access 
only allows the user to View the method file selected. 

Gel The user can toggle the gel bottle location to the desired bottle to use for the 
separation method without having to alter a predefined method.

Tray name The tray name appears as input by the user on the main screen or the default 
name appears. The user may edit this field by typing in the provided box. 

Folder prefix The folder prefix allows the user to add a prefix to the folder name where the 
results files will be written.

Copy results / Copy path The default directory location for the data is 
C:\Agilent Technologies\Data. The user may select the Copy Results option 
and choose to copy the saved data to a different location by selecting the […] 
option. 
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After the appropriate method is chosen from the drop-down menu select OK to 
add the chosen method to the Method Queue, or Cancel to close the window.

Create Size Calibration 
File

This is used for automated analysis (Chapter 12, “Fragment Analyzer – 
Automated Analysis”). When selected (and auto-processing is enabled), the 
run will be used to create a size calibration file, which will be used to calibrate 
the size of fragments in subsequent files. Upon completion of the run, a size 
calibration file will be named and placed into a file director as defined in the 
“Size cal file” section. 
Note: If both Create Size Calibration File and Use Size Calibration File boxes 
are unchecked, the system will assume the ladder is present in A12 or H12, as 
defined in the kit manuals.

Use Size Calibration File This is used for automated analysis (Chapter 12, “Fragment Analyzer – 
Automated Analysis”). When checked (and auto-processing is enabled) the 
program will use the size calibration file defined in the Size cal file section to 
define the sizes of DNA fragments.

Size Cal. File This is used for automated analysis (Chapter 12, “Fragment Analyzer – 
Automated Analysis”). The user defines a name and file location of the size 
calibration file. When Create Size Calibration File is checked, the program will 
write a .SCAL file to the defined name and location of the file. When Use Size 
Calibration File is checked, the program will import and use the .SCAL file at 
the defined location.
Note: The size calibration settings will only be visible on the Separation setup 
window when the Enable Automatic Reporting checkbox is selected in the 
Automated Report Settings window (Figure 23).

Notes The section allows for the addition of any additional information the user may 
require for a set of samples. 

Merge rows When selected, will merge 8-rows of 12 or 2 sets of 48-cap “runs” into a single 
run file. The original non-merged rows are also available for data processing. 
This function is useful when running 8 rows of 12, and the user wants to view 
the data file as a single 96-well file.
Note: The Merge rows function will only become available if you select Run 
Entire Tray > Add to queue selection for a 5200 Fragment Analyzer or for a 
48-capillary configured 5300 Fragment Analyzer.

Table 15 Separation setup window functions

Item Description
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Capillary Array - Conditioning

The Fragment Analyzer software provides several programmed capillary 
conditioning methods for cleaning and maintaining the capillary array.

The user can also select to create a method of their choosing by selecting the 
Edit Method option seen in Figure 40.

Selecting the check box next to the individual parameter can enable different 
bottles to be used for the conditioning. The individual parameters are discussed 
in Table 16.

Figure 40 Conditioning method editor
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Table 16 Separation setup window functions

The user can Load a new method, Save as a new method with a unique name, 
select OK to accept the method and close the window, or Cancel to close the 
method editor window and discard the changes.   

Selecting the Add to queue function will open the Select Conditioning Method 
window (Figure 41).

Figure 41 Select Conditioning Method window

You can select an already created method from the drop-down menu or click Edit 
to view the conditioning method editor window as seen in Figure 40.

After the appropriate method is chosen from the drop-down menu, select OK to 
add the chosen method to the Method Queue, or Cancel to close the window.

NOTE
These standalone conditioning methods can help with maintenance and basic 
troubleshooting. This is explained in more detail in “Capillary Array Cleaning” on 
page 137.

Item Description

Step #1, 2, or 3 Enables/disables the step to be used.

Solution Allows selection of the Conditioning solution, Gel 1, or Gel 2 reagent bottles for use.

Fill Pressure Default value is set to 280 psi. This can be changed from 1-300 psi.

Flow Rate Default value is set to 200 uL/s. This can be adjusted from 1-1000 uL/s .

Time This is set in minutes from 1 – 240.

Tray Allows the user to select the tray and row (12 capillary unit only) to pump into when 
conducting the conditioning (the default is the waste tray—and is the best option 
for most users).
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Method Queue

Once a sample tray or row/group has been selected and added to the queue, the 
method name and tray location is shown (Figure 42).

Figure 42 Method Queue 

Figure 42 shows three sample runs chosen from sample trays 1, 2, and 3 
followed by a pause in the method queue and a priming method.

A Pause or Prime can be inserted into the method queue by right clicking in the 
Method Queue area of the screen. When Insert Prime is selected, the Select 
Solution window will appear prompting the user to choose the Priming fluid from 
a drop-down menu (Figure 43).

Figure 43 Select Solution popup window

Methods loaded into the method queue can be moved up or down based on the 
user’s needs by left-clicking on the method and dragging it to the desired location 
in the queue.

To view the parameters for the separation method in the method queue select 
the Method Summary icon next to the separation method. A summary of the 
method will appear, as shown Figure 44.
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Figure 44 Method summary popup window

Selection of the Edit option from the Method Summary window allows the user to 
make final changes to the method if desired.

To delete a specific item on the queue, select the X icon next to the Separation 
Method. To delete all items in the queue, select  Clear from the Method Queue 
menu bar.   

To show a detailed summary of the run parameters associated with a method on 
an item in the queue, select  Down Arrows next to the Separation Method.

There are three Run Controls for the Method Queue, Clear the Method Queue, 
Pause the Method Queue, and Start the Method Queue. These Run Controls are 
described in Table 17, below.
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Table 17 Method queue run controls

Item Description

Clear: Selection of this icon will clear all separation methods, pauses, and primes from 
the queue.

Pause: Selection of this icon will pause the method queue. The current method running 
will still complete. To restart the queue, select Start (below).

Start: Selection of this icon will start the method queue. Once started the top method will 
disappear and the screen will switch to the Run Status tab. The next method will move 
up in the queue. 
Note: When you add a method or item to the queue, you must select Start to begin 
operation of the instrument.
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Permissible Characters

The following tables show which characters are permissible (Table 18) and 
non-permissible (Table 19) for a file name.

Table 18 Permissible characters for a file name

Table 19 Non-permissible characters for a file name

Characters

~ `

! @

# $

% ^

& (

) _

- +

= {

} [

] ;

, .

Characters

*| |

\ :

“ '

< >

? /
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9 Fragment Analyzer Software – Run Status Tab

Run Status Tab Overview 84
Stage Movement Animation 85
Conditioning Animation 86
Pre-Run / Injection View 87
Real-time Separation View 88
Status Bar 90

This chapter describes the Fragment Analyzer software in more detail on the Run 
Status tab.
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Run Status Tab Overview

Once a Start command  has been selected (for more information, refer to 
section Method Queue on page 79), the display will switch from the Operation tab 
to the Run Status tab. The Run Status tab has several features, as shown below.
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Stage Movement Animation

Whenever the stage moves from one position to another, the animation shown in 
Figure 45 will show where the Fragment Analyzer stage is moving to/from to 
give the user real time view of what is happening. 

Figure 45 Stage movement animation

NOTE
The animation does not time perfectly to the physical stage movements. We 
recommend to confirm all stage movements are finished by checking the drawer 
indicator lights. If you open a drawer before a stage movement has finished, the 
run is aborted.
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Conditioning Animation

When the Fragment Analyzer instrument is pumping conditioning solution or gel, 
the following animation is shown (Figure 46 ). The animation gives a real-time 
view of what the instrument is doing during a conditioning sequence (including 
fluid flows, valve switches, etc.).

Figure 46 Conditioning animation
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Pre-Run / Injection View

When the Fragment Analyzer system is completing a pre-run or injection, the 
screen as shown in Figure 47 will appear.

Figure 47 Pre-Run/Injection screen
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Real-time Separation View

When the Fragment Analyzer system performs a separation, the screen in 
Figure 48 appears, which shows a real-time view of the separation.

Figure 48 Real-time separation window

The user can view the run in a group of 12 electropherograms (as shown in 
Figure 48), or view individual electropherograms by selecting the Single tab 
located at the top. When a 96-capillary system is running, the user can select 
between groups of 12 or single electropherograms by selecting the appropriate 
row/capillary with the Group or Single tabs.

NOTE
In order to correctly view the real-time separation data, the capillary array must 
be aligned prior to starting the separation. For instructions on aligning the 
capillary array, refer to Chapter 7, “Fragment Analyzer Software – Utilities Menu”.

Other options available from the Run Status tab are described in Table 20.
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Table 20 Run Status Tab options

Icon Description

Opens a popup window showing the method summary for the current method 
being run.

Aborts only the individual task being done, i.e., stage movement, pumping, or 
injection.

Aborts the entire Method being run and begins the next method in the queue. If 
no methods are found, it returns to the storage position. When selected the 
user will be presented with a popup screen asking to verify they want to Abort 
the current run. 

Shows the current for the separation being performed.

Task Status Shows the status bar and time left for each individual task being 
accomplished, i.e., stage movement, pumping, or injection.

Method Status Shows the status bar and time left for the entire method to complete.
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Status Bar

The bottom bar of the Fragment Analyzer software shows a real time status bar 
containing important information about the instrument status. The icons and 
their function are discussed in Table 21.

Table 21 Instrument status information

Icon Description

Left-clicking on this icon will show the voltage level for the last 5 minutes.

Left-clicking on this icon will show the current level for the last 5 minutes. 

Left-clicking on this icon will show the pressure level for the last 5 minutes. 

Denotes if the Reservoir vent valve is open or closed.

Denotes if the Waste valve is open or closed.

Denotes the location of the stage at that point in time. 



5200, 5300, and 5400 Fragment Analyzer System Manual 91

10 Fragment Analyzer Capillary Array

Capillary Array Parts 92

Removal of the Capillary Array 93

Unpacking a New Capillary Array 103

Capillary Array Installation 106

This chapter explains the essential operational parameters of the capillary array.
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Capillary Array Parts

The Fragment Analyzer instrument capillary array allows for direct parallel 
injection and separation of 12-, 48-, or 96-samples at once. 

Figure 49 Capillary array parts (96-capillary array shown)

Capillary array bundle

Capillary array frame

Allignment pin

Capillary tips and electrodes



10 Fragment Analyzer Capillary Array
Removal of the Capillary Array

5200, 5300, and 5400 Fragment Analyzer System Manual 93

Removal of the Capillary Array

This section will provide a pictorial guide of the steps required to physically 
remove a capillary array cartridge from the Fragment Analyzer instrument.

Before proceeding with capillary array removal, select the park icon from the 
main screen to place the tray being help back into its drawer, and move the stage 
into a resting position.
1 Open the reagent door and top hood of the instrument:

First, open the reagent door to the side. 

When the reagent door is open, the top hood flips upwards.

Figure 50 Fragment Analyzer instrument
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WARNING
High voltage
The Fragment Analyzer contains a high voltage supply cable. It is marked by a 
hazardous voltage sticker. This cable sends electricity to the capillaries during 
any actions that use high voltage (pre-run, injections, separation). If the top 
compartment is not shut properly, the high voltage power supply will not be 
delivering any power to the cable.

Ensure that the cover is properly shut before operating the instrument.

2 Unplug the white high voltage supply cable for the top front panel, and place in 
the holder of the capillary array frame.

Figure 51 Instrument top compartment – high voltage supply cable

High voltage supply cable

Holder with high voltage plug
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3 Use the provided allen wrench to remove the two white screws that secure the 
light guide to the array window.

Figure 52 Instrument top compartment – unscrew light guide

4 Remove the light guide.

Figure 53 Instrument top compartment – light guide removal



10 Fragment Analyzer Capillary Array
Removal of the Capillary Array

5200, 5300, and 5400 Fragment Analyzer System Manual 96

Once the light guide has been removed, it can hang straight down into the 
reagent door compartment. It is recommended to close the reagent door to 
minimize light shining in any eyes. 

NOTE
Avoid looking directly at the LED light.

5 Pull back on the capillary reservoir connector slide.

Figure 54 Instrument top compartment – capillary reservoir connector slide
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6 Use the capillary reservoir connector tool to loosen the capillary array bundle 
by prying up on the bundle.

Figure 55 Instrument top compartment – capillary reservoir connector tool
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7 Remove the capillary array bundle by pulling up gently.

NOTE
Avoid pulling up hard as to not break any capillaries.

Figure 56 Instrument top compartment – capillary array bundle removal

8 Carefully insert the protective cover over the capillary bundle.

Figure 57 Instrument top compartment – installing protective cover
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9 Place the capillary array bundle on the top holder of the capillary array 
window.

Figure 58 Instrument top compartment – storing covered capillary array bundle
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CAUTION
Excessive force
Capillary breakage can occur when removing or installing the capillary array 
window. 

Take extra care not to use too much force when handling the capillary array 
window.

10 Remove the capillary array window from the window holder. Do not press on 
or touch the capillaries. 

Flip the array window after removal so that the capillary array bundle goes 
from the right to the left side of the array frame.

Figure 59 Instrument top compartment – remove capillary array window
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11 Attach the array window to the capillary array frame using the attachment 
screw.

Figure 60 Instrument top compartment – attach array window to capillary array frame

12 Use the provided allen wrench to remove the two white screws holding the 
capillary array in place.

Figure 61 Instrument top compartment – array attachment screw removal
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13 Carefully lift the array straight up to remove it from the Fragment Analyzer 
instrument.

Figure 62 Instrument top compartment – capillary array removal

Once removed from the instrument, the capillary array cartridge is ready for 
disposal or storage in the Fragment Analyzer wet station (“Long Term 
Capillary Array Storage” on page 150).
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Unpacking a New Capillary Array

This section will provide a pictorial guide of the steps required to physically 
unpack a new capillary array from the shipping container and packaging.
1 Unpack the new capillary array:

a Open box
b Remove foam cover.
c Lift array out of the packaging.
d Remove array from the plastic bag.

Figure 63 Capillary array shipping box

Take care not to break capillaries or touch the array window when removing 
packaging. Hold the array by the black plastic frame when handling.



10 Fragment Analyzer Capillary Array
Unpacking a New Capillary Array

5200, 5300, and 5400 Fragment Analyzer System Manual 104

2 Remove the capillary array bundle-securing rubber band.

Figure 64 Remove capillary array bundle-securing rubber band.

3 Remove the two white nylon screws that secure the array to the shipment 
frame.

Figure 65 Capillary array shipping box
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4 Carefully lift the array straight up to remove it from the shipment frame.

Figure 66 Capillary array shipping box – removal of array from shipment frame
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Capillary Array Installation

This section will provide a pictorial guide of the steps required to physically install 
a capillary array cartridge into the Fragment Analyzer instrument.

Before proceeding with Installation ensure the instrument is in the Park position. 
If it is not in the Park position, select the Park icon from the main screen to place 
the tray being help back into its drawer and move the Stage into resting position.
1 Open the reagent door and top hood of the instrument:

First, open the reagent door to the side. 

When the reagent door is open, the top hood flips upwards.

Figure 67 Fragment Analyzer instrument
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2 Carefully place the capillary array into the top compartment of the instrument 
with the array window facing out. 

The four alignment pins should align with the alignment holes in the 
instrument.

Figure 68 Instrument top compartment - capillary array installation: a 48 capillary is used in the example

3 Use the provided allen wrench to install the two white screws holding the 
capillary array in place.

Figure 69 Instrument top compartment - array attachment screw installation, picture indicates one of 
these screws
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4 Remove the array window attachment screw. 

Figure 70 Instrument top compartment – remove array window

5 Carefully flip the array window so that the capillary array bundle goes from the 
left to the right side of the instrument.

Position the capillary array window into the holder and firmly press it into 
place.

Do not press on or touch the capillaries.

Figure 71 Instrument top compartment – array window installation
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6 Remove the capillary array bundle from the top holder of the capillary array 
window.

Figure 72 Instrument top compartment – capillary array window installed, and bundle shown here

7 Carefully remove the protective cover from the capillary bundle and place it 
back on the holder on top of the window.

Figure 73 Instrument top compartment – removing protective cover
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8 Install the capillary array bundle by firmly pushing the capillary array bundle 
into the reservoir opening until a distinct click is heard.

Figure 74 Instrument top compartment – capillary array bundle installation
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CAUTION
Capillary array bundle improperly secured
If the capillary array bundle is unsecured, it will be damaged upon 
pressurization.

Check that the capillary array bundle is secured.

9 Push in the capillary reservoir connector slide to secure the capillary array 
bundle.

Figure 75 Instrument top compartment – capillary reservoir connector slide
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10 Place the light guide over the array window using the two alignment pins. 

The finger hold should be facing the right side of the instrument.

The steel optical cable should be on the left.

Figure 76 Instrument top compartment – light guide placement
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11 Use the provided allen wrench to install the two white nylon screws that 
secure the light guide to the array window.

Figure 77 Instrument top compartment – light guide installation



10 Fragment Analyzer Capillary Array
Capillary Array Installation

5200, 5300, and 5400 Fragment Analyzer System Manual 114

CAUTION
Loss of time and reagents
If the capillary high voltage supply cable is disconnected from the instrument, 
the conditioning and gel steps will still be completed before the software 
aborts the method and signals an error.

Ensure that the high voltage supply cable is connected before starting a 
method.

12 Remove the high voltage cable from the array frame holder and firmly push it 
into the high voltage cable connection.

Figure 78 Instrument top compartment –fully installed array 48 capillary array shown here

13 Double check all of the installation points on the capillary array:

Array base secured with two nylon screws

Array window installation

Light guide installed with two nylon screws

Capillary bundle installed in reservoir

Reservoir slide in locked position

HV cable installed

High voltage supply 
cable
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14 Close the reagent door and top hood of the instrument.

Figure 79 Fragment Analyzer instrument

After installation of an array, the Fragment Analyzer will require a capillary 
alignment as described in Chapter 6, “Fragment Analyzer Software – Utilities 
Menu”.
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11 Fragment Analyzer – Sample Name Entry

Sample Name Entry 117
Entering Sample Names Manually 117
Importing Sample Names 118
Importing Sample Names Using a Bar-Code Reader 120

This chapter provides information on how to enter the sample names in the 
Fragment Analyzer software.
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Sample Name Entry

Entering Sample Names Manually

1 From the Operation tab, select the tray number, the desired row, and the 
sample cell. 

2 In the field Sample ID, enter the desired sample names.
3 Select the Save tray or Save selected row to save the file as a .txt or .csv 

(Figure 80).

Figure 80 Adding samples names manually
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Importing Sample Names

The files must be available in .txt or .csv file format. 

The data format must comply with the format described below in order for the 
system to read the files correctly. 

1 In the Operation tab, select Load from file to load a set of saved or previously 
created sample names.
• For a .txt file, the sample names must be arranged in a single column 

(Figure 81).

Figure 81 .txt file format (single row of names—no well numbers or row numbers).
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• For a .csv file, the column format is row number, well number, and sample 
name (Figure 82). 

Figure 82 .csv file format: row number, well number, and sample name
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Importing Sample Names Using a Bar-Code Reader

For the purposes of sample name import, a bar-code reader is equivalent to a 
keyboard. When a bar-code is read, the program searches the Samples folder for 
a name that is identical to the bar-code. If a name is found, then the file (and the 
corresponding sample names) is imported.

NOTE
No bar-code scanner is provided with the Fragment Analyzer system.

1 Place the sample name files into the C:\Agilent Technologies\Samples folder 
(Figure 83). If a folder does not exist, create a new Samples folder. The 
sample name file can be either a .txt file or .csv file (using the formats 
described in section “Importing Sample Names” on page 118). 

The sample name files can be created by an user, or automatically by a LIMS 
system.

Figure 83 Samples folder

It is critical that the name of the file is identical to what is read by the bar-code 
reader. 

Example: 

In Figure 84, the name associated with the bar-code is 00060065.
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Figure 84 Bar-code name 00060065

Thus, the .csv file or .txt file must be given the file name 00060065 and located 
in the Samples folder (Figure 85).

Figure 85 File name

2 In the field Tray name of the Operation tab, highlight the tray name with the 
mouse cursor (Figure 86).

Figure 86 Highlight of the tray name
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3 Use the bar-code reader to scan the bar-code on the plate. 

The file name and the sample names will be automatically imported from the 
.txt or .csv file of the Samples folder (Figure 87).

Figure 87 Imported sample names
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Enabling Automated Analysis 125
Monitoring the Status of the Automated Processed Data 129

This chapter explains the procedure for automated analysis using the Fragment 
Analyzer.
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Automated Analysis Using the Fragment 
Analyzer

Automated analysis is performed by the Fragment Analyzer software at the end 
of a run using ProSize. Instead of manually opening a file and exporting the 
results (for example, pdf, peak table, smear table, etc.) this is done automatically 
at the end of each run.

Automated analysis is applicable to labs that always run the same type of 
sample. 

Automated analysis is ideally suited for linking the Fragment Analyzer to a LIMS 
system. Sample names can be generated by the LIMS system and imported via 
plate bar coding (refer to Chapter 11, “Fragment Analyzer – Sample Name 
Entry”). Sample results are automatically exported via automated analysis. Error 
logs on automated analysis are located in .txt files that can be monitored by the 
LIMS system.

Automated analysis should not be done in sample matrices where results are 
unpredictable (broad, messy peaks, complex mixtures, low sample quantity, etc.).
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Enabling Automated Analysis

1 From the Administrator drop-down menu, select Results Report Setup 
(Figure 88).

Figure 88 Admin menu

This will open the Automated Report Settings window (Figure 89).

Figure 89 Automated Report Settings window



12 Fragment Analyzer – Automated Analysis
Automated Analysis Using the Fragment Analyzer

5200, 5300, and 5400 Fragment Analyzer System Manual 126

2 To enable automated analysis, select Enable Automatic Reporting.
3 Select the desired export options (PDF, etc.).

Each of the export options (PDF, Standard peak table, etc.) are described in 
Chapter 7, “Exporting Data from ProSize“, and Chapter 8, “Generating Reports 
from ProSize“ of the ProSize Data Analysis Software User Manual.

The Report output path defines where the exported data is placed. If this field 
is left empty, the exported data will be placed into the original data folder. 
Create an output folder in a desired location other than the data folder, if 
desired.

For automated analysis to work correctly there are two main criteria that must be 
met:
• The name of the method in the Fragment Analyzer system (used to acquire 

the data) must exactly match the name of the configuration file in ProSize.

For example, if the method used to run the sample is DNF-905-33 - DNA 
1-500bp, then the configuration file in ProSize must have the name 
DNF-905-33 - DNA 1-500bp.

• If not using an imported ladder, the ladder well must be able to be processed 
by ProSize If the ladder well is not read correctly, then the data will not be 
processed. This means that the configuration file in ProSize must be set 
correctly—so that the ladder well is correctly read. This also means that ladder 
well must be of high quality, without anomalous or missing peaks.

For example, assume a 100 bp ladder is used in well H12, but the 
configuration file in ProSize is set so that the minimum peak height for 
integration of the ladder is 5.000 units. In this case, the ladder is not read 
correctly by ProSize (i.e., many ladder elements are missing), and the file will 
not be auto-processed by the Fragment Analyzer system (Figure 90).
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Figure 90 ProSize calibration curve setup

If the configuration file is set with a minimum peak height of 500, then the ladder 
is processed correctly by ProSize, and all the ladder elements are recognized 
(Figure 91).

Figure 91 ProSize calibration curve setup
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Importing a Ladder File for Automated Analysis

The Fragment Analyzer system uses ProSize to perform automated processing. 
Thus, you must utilize ProSize to modify configuration files, which defines how 
the data is processed. In the example above, you would change (and save) the 
minimum peak height from 5.000 to 500 in the configuration file using ProSize. 

Both ProSize and the Fragment Analyzer software gives you the option of using 
an imported ladder file. For batch or automated processing, the use of imported 
ladders has several advantages:
• You can use all 96-wells of the sample plate, without having to reserve well 

H12 for the ladder.
• A high-quality, saved ladder file allows you to process many subsequent files 

without the need for re-calibration.
• A high-quality ladder file eliminates the chance of a bad auto-processed file 

due to a poor quality of a sample plate ladder (i.e., a ladder well that has poor 
signal, missing, or poorly resolved peaks). 
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Monitoring the Status of the Automated Processed Data

The Results Dashboard allows you to quickly determine the status of 
post-processed data. 
1 From the Utilities drop-down menu, select Results dashboard (Figure 92).

Figure 92 Utilities menu

The Results Dashboard window opens. The data files are listed (Figure 93).
2 Right-click on a file. 

Figure 93 Results Dashboard

a From the menu, select View with Prosize to open and review the file in 
ProSize.

b Select Error Log to view the error messages.

A summary of error messages is given in Table 22.
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Table 22 Results Dashboard error messages

The error messages are also recorded under
C:\ProSize data analysis software\Error Log. An example error log file is shown in 
Figure 94.

Since this is a .txt file, the error can be monitored by a LIMS system to report the 
status or accuracy of auto-processing.

Figure 94 Example error message

Message Description

Error Status Gives a statement of the status of processing. If there is an issue, ISSUES will appear.

Critical Error Either a) the method name did not match the configuration file name, or b) the ladder 
file could not be processed correctly.

Input Error A user asked for something that could not be generated, such as a flag summary 
when no flag conditions were set, or a smear table, when the configuration file has no 
smear conditions.

Generation Error There was an issue with the generation of a file (.csv, .pdf, or .txt) (usually associated 
with some operating system error).

Individual Error There is a problem with an individual capillary, such as a missing upper or lower 
marker, or unusually broad marker peaks.
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This chapter provides additional information on maintenance procedures and 
system settings.

NOTE
If you require assistance, contact your local Agilent support representative.
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Compatible Plates and Tubes for Fragment 
Analyzer Systems

NOTE
The plates listed in this section were confirmed compatible when this manual 
revision was completed. Plate manufactures may make changes, causing 
incompatibility.

Semi-Skirt Sample/Marker Plates – 5200 and 5300 only

The 5200 and 5300 Fragment Analyzer systems operate using specific 
dimensioned Eppendorf 96-Well twin.tec PCR plates, semi-skirted (Eppendorf 
#951020303 (various colors)).

NOTE
Non-skirted PCR plates are not recommended for use with the Fragment 
Analyzer systems, as they tend to warp or bow and can therefore interfere with 
proper sample injection.

CAUTION
Wrong plate dimensions
The Fragment Analyzer requires plates of the following dimensions:
123.7 × 82.2 × 19.7 mm (length × width × height). Semi-skirt platform – 
9.1 mm.

The use of PCR plates with different dimensions can lead to decreased 
injection quality and consistency. Damage to the capillary array cartridge tips 
is also possible.

 Use only plates with the correct dimensions.
 If you use plates outside the approved plates listed above, make sure to 

qualify them.
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0.2 mL Tube Strip – 5200 and 5300 only

The 5200 and 5300 Fragment Analyzer systems have been designed to work 
with specific strip tubes when using the F1300-107 Tray Carrier – 12 Vial Strip 
(sold separately). A list of approved tube strips is provided in Table 23.

NOTE
The use of PCR tube strips with different dimensions to the below recommended 
tubes could lead to decreased injection quality and consistency. Damage to the 
capillary array cartridge tips is also possible.

Table 23 List of approved tube strips

Item Vendor / Part # Description

0.2 mL PCR 12-Tube Strip Fisher Scientific #AB-1113 Thermo Scientific ABgne 0.2 mL Strip Tubes > 12-Tube Strip

0.2 mL PCR 8-Tube Strip Fisher Scientific #AB-266 Thermo Scientific ABgne 0.2 mL Strip Tubes > 8-Tube Strip
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Buffer/Waste Plates – 5200, 5300, and 5400

The 5200, 5300, and 5400 Fragment Analyzer systems uses a specific deep 
96-well plate (31 mm height) supplied by Fisher Scientific (Part # 12-566-120) for 
the buffer and waste plate. This specific plate must be used with the instrument 
(two plates are supplied upon installation) (shown in Table 24). 

Standard 1 mL deep well, half height, or square well 1 mL 96-well plates should 
not be used as buffer/waste plates with the Fragment Analyzer system, as 
damage to the capillary array will occur.

The same specified buffer/waste plate is also available directly from Agilent, if 
these plates cannot be obtained directly from the manufacturer.

Table 24 List of Buffer/Waste Plate

Item Vendor / Part # Description

Buffer/ Waste Deep 96-Well Plates Fisher Scientific #12-566-120 Fisherbrand 96-Well DeepWell Polypropylene Microplates: 
Well Capacity 1 mL
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Full Skirt Sample/Marker Plates – 5200, 5300, and 5400

The 5400 Fragment Analyzer system has been designed to work exclusively with 
full skirted PCR plates. This instrument is shipped with a set of special plate 
adapters: F1350-001 – Full Skirt Tray Carrier.

NOTE
The 5400 Fragment Analyzer will not function properly with the semi-skirted 
plates. However, the 5200 and 5300 Fragment Analyzer has the option to use 
either of these plate options: full skirted, semi-skirted, provided that the proper 
drawer adapter insert is present (shown in Table ).

If you use the 5200 or 5300, you can purchase full-skirt plate adapters to replace 
the default semi-skirted adapters that come with the instrument. If you do so, you 
need to purchase the full set so the instrument only uses one type or the other. 
The adapter part number is: M1300-109 – DRAWER ADAPTER-FULL SKIRT 96 
WELLPLATES.

Supported full-skirted plate:

Eppendorf twin.tec 96 Well LoBind PCR plates, skirted (Fisher Scientific 
#E0030129512)

NOTE
The use of PCR plates with different dimensions to the above recommended 
plates could lead to decreased injection quality and consistency. Damage to the 
capillary array cartridge tips is also possible.



13 Maintenance and Troubleshooting
Preventative Maintenance Schedule

5200, 5300, and 5400 Fragment Analyzer System Manual 136

Preventative Maintenance Schedule

Daily Maintenance

Empty the waste bottle and waste tray.

Replace the inlet buffer in the buffer tray position.

Replace rinse buffer solution when applicable.

Ensure there is Capillary Conditioning Solution in the conditioning solution 
bottle location.

Ensure there is gel/dye in the gel bottle location.

Monthly Maintenance

Replace the buffer and waste plates with new ones.

Replace the Capillary Storage Solution and plate.*

Replace the gel and conditioning solution bottles with new ones.

Clean both gel and conditioning solution lids with IPA or EtOH.

Inspect the reservoir vent valve for dried gel, clean if necessary.

As Needed to Restore Separation Performance

Place 0.6 mL of 0.5N NaOH into each well of a Deep Well plate (Row A for 
12 capillaries, Rows A – D for 48 capillaries, all rows for 96 capillaries). Place 
this plate in the waste tray location and flush the capillary array cartridge with 
0.5N NaOH followed by capillary conditioning solution as described in section 
“Capillary Array Cleaning” on page 137.**

* More frequent replacement (i.e., every 1-2 weeks) may be required in low humidity or warmer laboratory 
environments.
** It is fine to perform this cleaning performance as a part of a regular weekly or biweekly cleaning schedule 
as well.
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Capillary Array Cleaning

The capillary array may require troubleshooting at times. This troubleshooting 
can cover several issues including physical clogs, delayed migrations 
(conditioning deficiencies), and contamination

There are typically four procedures to clean/flush a capillary array to improve 
performance due to the above mentioned issues.

NOTE
Most clogging will be caused by dried reagents on the capillary tips on the plate 
side. The tip soaks listed below are the best approved methods to remove these 
blockages

• Method A: Flow check with CE grade water
• Method B: Tip soak – Submerse capillary array tips/electrodes in hot water 

(150 °F – 200 °F)
• Method C: 0.5N NaOH flush and soak to clean the capillary tips, electrodes, 

and capillary walls
• Extended conditioning flush: typically 10 – 20 minute flush of conditioning 

solution to help coat the capillary walls and facilitate even migrations (this is 
not a pre-made method in the FA software).

A combination of two or more of the methods outlined below may be required in 
some cases.
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Method A – Flow Check with CE Grade Water

When a capillary array is suspected to have any clogged capillaries, the first step 
is to flush the array with CE grade water.
1 From the operations tab located on the main screen window, select Add to 

queue under the Capillary Array-Conditioning menu.
2 From the Select Conditioning Method window, select Method A Flush - Water - 

10 min 200 psi.mthdc from the drop-down menu. 
3 Select Edit to ensure that the method matches the parameters shown in 

Figure 95. 

Figure 95 Conditioning parameter Method A Flush – Water – 10 min 200 psi.mthdc

4 If necessary, adjust the method to that shown in the Figure 95 (on a 
96-capillary instrument, the parameter Row is not editable). 

5 Select OK.
6 Select OK again to add the method to the method queue. 
7 Open the Waste Drawer (second drawer from top) and place an empty 96-Well 

Deep Well Plate onto the plate holder. 
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8 Open the Fragment Analyzer systems’ side compartment to replace the gel 2 
bottle with a bottle containing CE grade water. 

Minimum solution volume required to run Method A Flush:
• ≥ 12 mL for a 12-capillary array
• ≥ 27 mL for a 48-capillary array
• ≥ 43 mL for a 96-capillary array

9 Close the door to the instrument side compartment, and select the start icon 
from the method queue to run the capillary conditioning method. 

10 Once the capillary array conditioning method is complete, open the waste 
drawer and remove the 96-well deep well plate. 

11 Check the volume of water present in each of the wells used for the flush.

For a 10-minute flush there should be ~150 µL of CE grade water in each well.

If a well has significantly less or no water present in a well, it is recommended to 
proceed to Method B or C.
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If the waste plate has similar amounts of water present in each well:

1 Remove the 96-well deepwell plate from the waste drawer and replace it with 
the open waste trough.

2 Open the side compartment of the Fragment Analyzer instrument and ensure 
there is conditioning solution and separation gel present to perform a full 
conditioning method.

Figure 96 Conditioning method editor

3 Perform a separation run to confirm all capillaries are providing signal.
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Method B – Submerse Capillary Array Tips/Electrodes 
in Hot Water (150 °F – 200 °F)

1 Select the park icon in the main screen window to place the plate being held 
back into its respective drawer and move the stage platform to the bottom of 
the instrument. 

2 Fill a 96-well deep well plate with 1 mL of hot water (150 °F to 200 °F) for 
soaking the tips of the capillary array.
• For a 12-capillary array, fill each well in row A of a 96-well deep well plate 

with 1 mL of hot water.
• For a 48-capillary array, fill each well in row A-D of a 96-well deep well plate 

with 1 mL of hot water. 
• For a 96-capillary array, fill each well of the 96-well deep well plate with 

1 mL of hot water. 
3 Open the buffer drawer (first drawer from top) and place the hot water filled 

96-well deep well plate onto the plate spacer. 
4 Close the buffer drawer securely. 
5 From the main screen window, locate the hotel positioning icons under the 

Operation tab. Select the Buffer icon to position the plate underneath the 
capillary array. 

6 Allow the capillary array to soak for a minimum of 15 minutes to one hour.
7 Select the park icon to return the 96-well deep well plate to the buffer drawer 

and place the stage in a resting position at the bottom of the instrument. 
8 Perform Method A as described in this Appendix to check the flow of solution 

through each capillary, or proceed directly to Method C.
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Method C – Cleaning the Capillary Tips, Electrodes, and 
Capillary Walls

WARNING
Hazardous solvent
0.5 N NaOH is corrosive and the handling of this solvent can hold health and 
safety risks. It causes severe eye and skin burns.

Avoid contact with eyes, skin, or clothing. 
Wear eye protection and impervious gloves. 
Refer to the SDS for all warnings and precautions before proceeding.

NOTE
The Method C cleaning protocol serves several purposes including the removal 
of clogs, decontamination, and resetting/cleaning of the capillary walls. It is 
important that the NaOH solution is not in contact with the capillaries for 
extended periods of time as this can lead to damage to the capillary itself. For 
this reason, the pre-made Method C flush in the software includes a conditioning 
flush to follow the NaOH step.

Method C – 0.5 N NaOH – 10 min 200 psi.mthdc is the best method for opening 
clogged capillaries, returning separation to normal as well as ridding the 
Fragment Analyzer systems of contamination. The NaOH tip soak portion of this 
cleaning procedure is very important for removing contamination that is present 
on the capillary tips – notably RNase contamination which may be present if the 
user is running both RNA and DNA kits.
1 Clean the Conditioning solution, Gel 1, and Gel 2 bottle caps with isopropanol 

or EtOH.
2 Open the Fragment Analyzer side compartment and replace the Gel 2 bottle 

with a bottle containing 0.5N NaOH. 

The minimum solution volumes required that are listed below are only for the 
first step of the Method C flush (a 10-minute pressurization with the NaOH in 
the Gel 2 line.) If performing the NaOH priming step of the liquid lines, add 
2.5 mL for each prime enabled:
• ≥ 12 mL for a 12-capillary array
• ≥ 27 mL for a 48-capillary array
• ≥ 43 mL for a 96-capillary array
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NOTE
If there are no contamination concerns and you are using method C to help 
restore capillary performance, you can skip the priming steps 3 and 4, and 
proceed immediately with step 5.

3 From the Utilities menu, select Prime. Select the check boxes next to the lines 
that are to be primed. For decontamination, we recommend priming all three 
liquid lines. For any lines that need to be primed with NaOH, you can place 
each of the lines in single 0.5 N NaOH bottle without screwing the caps on. 
This will be easier than filling three separate bottles with NaOH.

4 Select OK to prime the chosen liquid lines with NaOH.
5 Place a new bottle with new conditioning solution in the conditioning solution 

position. 

The minimum solution volumes required are only for the second step of the 
Method C flush (a 10-minute pressurization with the conditioning solution in 
the cond. line.) Ensure that at least 2.5 mL extra conditioning solution is added 
to this line if performing a priming step prior to the flush.

Minimum solution volumes:
• ≥ 12 mL for a 12-capillary array
• ≥ 27 mL for a 48-capillary array
• ≥ 43 mL for a 96-capillary array

6 From the Operation tab located on the main screen window, select Add to 
queue under the Capillary Array - Conditioning commands menu.

7 From the Select Conditioning Method window, select the Method C Flush - 0.5 N 
NaOH - 10 min 200 psi.mthdc from the drop-down menu. 

8 Select Edit to ensure that the method matches the parameters seen in 
Figure 97.



13 Maintenance and Troubleshooting
Capillary Array Cleaning

5200, 5300, and 5400 Fragment Analyzer System Manual 144

Figure 97 Conditioning parameter Method C Flush - 0.5 N NaOH - 10 min 200 psi.mthdc 

9 If necessary, adjust the method to that shown in Figure 97 (Row will not be 
selectable on a 96-capillary instrument).

10 Select OK.
11 Select OK again to add the method to the Method Queue. 

NOTE
The NaOH tip soak portion of this cleaning procedure is very important for 
removing contamination that is present on the capillary tips – notably RNase 
contamination which may be present if the user is running both RNA and DNA 
kits.

12 Open the waste drawer (second drawer from top) and place a 96-Well deep 
well plate filled with 0.6mL per well of 0.5N NaOH in Row A for a 12-capillary 
array, rows A-D for a 48-capillary array, or all 96 wells for a 96-capillary array 
onto the plate holder. 

13 Close the door to the Instrument side compartment and select the green start 
icon from the Method Queue to run the capillary conditioning method. 



13 Maintenance and Troubleshooting
Capillary Array Cleaning

5200, 5300, and 5400 Fragment Analyzer System Manual 145

14 Once the capillary array conditioning method is complete, open the waste 
drawer and remove the 96-well deep well plate. Check the volume of solution 
present in each of the wells.

The waste tray wells will be full. Ensure all wells have a similar amount of 
waste present.

15 Empty the 96-well deep well plate in the proper aqueous waste disposal area 
and return it to the waste drawer (second drawer from the top).

CAUTION
0.5N NaOH is corrosive

0.5N NaOH can damage the capillary array.
Once your cleaning protocols are finished, perform a Full Conditioning flush 
(with gel as last step) or proceed to the next separation method. Separation 
gel is the best reagent to be present within the capillaries for long durations.

NOTE
When conditioning flushes are recommended it is important to use conditioning 
solution at the 1x concentration. Using a reagent aside from conditioning 
solution to prepare the capillaries can be detrimental to separation quality.
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Long Conditioning Flush

If there is a delay in migration or smeared migrations, perform a long 
conditioning flush of 10 – 20 minutes in addition to the Method C flush.

This is not a preset method, but it can be added manually.
1 Go to the Capilllary Array > Conditioning Edit Method menu.
2 Place a sufficient volume of Conditioning Solution in the conditioning solution 

position.
3 Ensure an empty trough is in the Waste position.
4 Add the method with only conditioning solution for 10 – 20 minutes to the 

queue.
5 Run the method.

NOTE
This process may change the default settings of the conditioning method being 
edited (Default Conditioning, Method A, etc.).
If the original settings are unknown, click Restore Defaults before using these 
conditioning methods the next time.
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Reservoir Vent Valve Cleaning

Over time the reservoir vent valve may become clogged and require cleaning. The 
Fragment Analyzer instrument has a reservoir vent valve luer lock fitting and 
syringe, allowing you to flush the valve using the Clean Reservoir Vent Valve 
command from the Utilities menu.
1 From the Utilities menu, select Clean Reservoir Vent Valve.

The Clean Reservoir Vent Valve window opens (Figure 98). 

Figure 98 Clean Reservoir Vent Valve window.

2 Follow the on-screen instructions to clean the reservoir vent valve.

NOTE
When performing recommended vent valve flushing, it is sometimes required to 
perform the flush procedure more than once. Filling multiple syringes with water 
prior to the final flush with air can be conducive to breaking up any debris in the 
valve. It may be additionally recommended to include 0.5 N NaOH solution in the 
flush before flushing with water and air for particularly difficult cases.



13 Maintenance and Troubleshooting
Capillary Array Window Cleaning

5200, 5300, and 5400 Fragment Analyzer System Manual 148

Capillary Array Window Cleaning

1 Open the side door and hood of the Fragment Analyzer instrument.
2 Remove the light guide from the array window.
3 Use a small nylon paintbrush or Kim-Wipe to gently clean the dust off the 

window while the window is dry. Brush across the window from left to right or 
right to left, not up and down. 

NOTE
The dust is typically on the capillaries due to static cling and can be removed 
quite easily with this step. If more intensive cleaning is needed proceed to 
steps 4 – 9.

4 Remove the bundle end of the capillary array using the capillary array bundle 
removal tool. Place bundle in provided protective cover.

5 Remove the capillary array window from the capillary array window holder. Do 
not touch the array window.

6 Place a paper tower behind the capillary array window as shown in Figure 99. 

Figure 99 Capillary array window with paper towel behind
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7 Using a spray bottle filled with 70% isopropanol or ethanol solution, gently 
spray the capillary array window.

8 Use a small nylon paintbrush to gently brush the capillaries in one direction 
while they are still wet. Alternatively, a Kim-Wipe can be used to blot the array 
window dry.

NOTE
It is important to let the capillaries air dry before reattaching the light guide. The 
alcohol solution can be evaporated by the light guide and then condense on the 
glass filter behind the array window.

9 Reinstall the capillary array window, bundle, and light guide.
10 Perform a separation on the Fragment Analyzer instrument.
11  Check the alignment of the capillaries when finished by navigating to Utilities 

> Capillary alignment. Realign if necessary.
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Long Term Capillary Array Storage

Long term storage is considered longer than two weeks without use. There are 
two methods for storing a capillary array for long term. 
• Leave the capillary array installed in the instrument (recommended in most 

cases).

Replace the Capillary Storage Solution monthly; in drier climates it may be 
required to change the Capillary Storage Solution more frequently, i.e., every 
one to two weeks.

• Use the external array docking station that ships with all new Fragment 
Analyzer instruments as part of the instrument accessory kit.

Using the array docking station

1 Remove the capillary array from the instrument. For detailed instructions, 
refer to Chapter 10, “Fragment Analyzer Capillary Array”.

2 Place the tray base inside the array docking station as shown in Figure 100.

Figure 100 Array docking station with tray base installed
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3 Place a 96-deep well tray (Agilent part #P60-20 or Fisher part # 12-566-120) 
into the array docking station with tray base (Figure 101). 
• 12-capillary array – Fill row A only with 1.0 mL storage solution.
• 48-capillary array – Fill rows A-D only with 1.0 mL storage solution.
• 96-capillary array – Fill all wells 1.0 mL storage solution.

Figure 101 Array docking station with 96-deep well tray

4 Place capillary array into the array docking station using the four leg holes as 
guides. For 12- and 48-capillary arrays ensure that the capillary tips are in the 
storage solution side of the tray, not left in open air. 

5 Insert the two white screws as shown in Figure 102 to tighten the capillary 
array into place.

 

Figure 102 Array docking station with capillary array installed
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6 Fill the provided glass vial with 20 mL of Capillary Storage Solution and place 
into the array spindle storage device.

Figure 103 Array spindle storage device, no storage solution in this example bottle

7 Slide the array spindle storage device onto the capillary array side arm, 
located to the left of the capillary array window, and screw the locking screw 
into place as shown in Figure 104. 

To see a full image of the array with the array spindle storage device installed, 
refer to Figure 105.

Figure 104 Array spindle storage device installation
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8 Remove the capillary array outlet spindle from the black storage plug and 
place it into the array spindle storage device as shown in Figure 105.

Figure 105 Array docking station with array installed

9 Replace the capillary storage solution monthly; in drier climates it may be 
required to change the storage solution more frequently, i.e., every one to two 
weeks.

NOTE
Depending on the capillary array size there are two different cap sizes for the 
glass vial on the array spindle storage device. The cap with a smaller opening is 
used for 12-capillary arrays, the cap with the larger opening is for the 48- or 
96-capillary arrays.
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NOTE This chapter provides additional information on part numbers, maintenance 
procedures, and system settings.
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5400 Fragment Analyzer System

This chapter applies only to customers who have purchased the 5400 Fragment 
Analyzer system.

The 5400 Fragment Analyzer is designed to allow an external robotic system to 
interface with the Fragment Analyzer. Each separate drawer of the 
5400 Fragment Analyzer system is pushed out or pulled in using remote serial 
commands. All Fragment Analyzer methods, conditioning steps, and stage 
movements can be controlled with remote commands, enabling extended walk 
away use of the instrument.

The 5400 Fragment Analyzer system can also be used as a stand-alone, normal 
operation Fragment Analyzer. For use in the stand-alone mode, no special set-up 
or commands are required – just use the system as a standard Fragment 
Analyzer. Note however that some slight differences exist in the instrument 
drawer assignments from a standard Fragment Analyzer, as outlined in the 
following sections. 

NOTE
The information given in Maintenance and Troubleshooting section also applies 
to this subset of the Fragment Analyzer.
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Drawer Assignments

The 5400 Fragment Analyzer system has specific drawer assignments, as shown 
below in Figure 106. 

The drawers are labeled from top to bottom as: 
• B (Buffer)
• W (Waste)
• M (Marker; also used as Rinse drawer with quantitative Fragment Analyzer 

kits) 
• S (Storage)
• 1 (Sample Tray 1; sole drawer for loading sample plates)

Figure 106 Entry points of the Fragment Analyzer system

B (Buffer)

M (Marker; also used as Rinse plate)

W (Waste)

S (Storage)

1 Sample Tray
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Important System and Workflow Considerations

This section covers important aspects of 5400 Fragment Analyzer system 
operation that should be considered when setting up experimental workflows 
with the system.

Buffer Plate Information

The 5400 Fragment Analyzer system uses the same specific deep 96-well plate 
(31 mm height) Buffer plates used on the Fragment Analyzer instrument. The 
plates can be purchased from either Fisher Scientific or directly from Agilent. 
This specific plate must be used with the instrument (two plates are supplied 
upon installation).

Table 25 List of Buffer plates

Item Approved Vendor / Part Number # Description

Buffer/ 96-Well Plates

Fisherbrand # 12-566-120 Fisherbrand 96-Well DeepWell Polypropylene Microplates; 
Well Capacity: 1 mL

Agilent # P60-20 Fragment Analyzer 96-Well Buffer Tray, case of 50
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Waste Plate Information

The 5400 Fragment Analyzer system uses a specific open polypropylene 
reservoir as the Waste plate. This plate provides a solid wall construction for 
robotic handling while furnishing sufficient volume for repetitive run cycles prior 
to emptying/exchange.

Table 26 List of Waste plates

Sample Plate Information

The 5400 Fragment Analyzer system is configured to work with full-skirt PCR 
microplates only. The same plates should be used for sample, marker/rinse and 
storage solution. The current plate options are listed below.

Table 27 List of PCR plates

NOTE
The use of PCR plates with different dimensions to the above recommended 
plates could lead to decreased injection quality and consistency. Damage to the 
capillary array cartridge tips is also possible.

Item Approved Vendor / Part Number # Description

Waste Plates Seahorse Bioscience # 200686-100, or
Fisher Scientific # NC0254486

Seahorse single cavity polypropylene reservoir, 170ml, 
12-column base geometry, 30.6mm height, case of 25

Item Approved Vendor / Part Number # Description

Sample/Marker/Storage 
PCR Plates (full-skirted)

Eppendorf # 951020401 (various colors) Eppendorf* 96-Well twin.tec* PCR Plates, Full-skirted
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Buffer, Waste, Marker/Rinse and Storage Plate Replacement Intervals

When operating the 5400 Fragment Analyzer system in unattended robotic 
control mode, the following plate replacement intervals are recommended (can 
be done, manually, or with a robot): 
• Buffer Plate – DNA kits/methods: A volume of 1.0 mL/well should be initially 

added to the Buffer plate. The buffer in the Buffer tray should be replaced 
once every 24 hours, or once per 24 runs (whichever comes first).

• Buffer Plate – RNA kits/methods: A volume of 1.0 mL/well should be initially 
added to the Buffer plate. Because all RNA methods pump gel matrix into the 
Buffer tray, the buffer in the Buffer tray should be replaced once every eight 
runs.

• Waste Plate: The Waste tray should be emptied after every six runs, 
maximum.

• Rinse Plate (Quantitative Kits): A volume of 200 µL/well should be placed into 
the Rinse plate. The Rinse plate should be replaced every 24 hours. 

• Marker Plate (Qualitative Kits): Refer to the respective Analysis Kit manual for 
recommendations on plate preparation and usage intervals.

• Storage Plate: The Storage tray should be filled with 100 µL/well of Capillary 
Storage Solution, Agilent Part # GP-440-0100. The Storage plate should be 
replaced at least once per month; more frequent replacement 
(one to two weeks) may be required when operating in warm or low humidity 
environments.

NOTE
The Buffer and Waste plates in particular must be replaced according to the 
suggested intervals, to prevent potential overflow and damage to the capillary 
array cartridge or instrument.
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5400 Fragment Analyzer Automated Data Analysis

The 5400 Fragment Analyzer software contains tools for performing automated 
data analysis post run, similar to the Fragment Analyzer system. 

Activate the automated data analysis features

1 From the Main menu, select Admin-Results Report Setup. 

The Automated Report Settings window will be displayed (Figure 107). 

Figure 107 5400 Fragment Analyzer Automated Report Settings window

2 Select Enable Automatic Reporting to turn on the automated data analysis 
feature.

3 Select which types of report are to be generated by selecting the appropriate 
box in the menu (for example, selecting PDF will automatically generate a PDF 
report post run).

NOTE
The report, export fields, or settings used in the Result output path will match 
those last saved in the ProSize data analysis program.

The automated data analysis settings need only be set once in the software 
during robotic integration process. For further information on performing 
automated data analysis, refer to Chapter 12, “Fragment Analyzer – Automated 
Analysis”.
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5400 Fragment Analyzer Communication Specifications

The 5400 Fragment Analyzer system can be interfaced to a robotic plate 
handling system by a serial port or by a TCP/IP port. The specifications for each 
are listed below.

Serial Port Communication

The host robotic sample handler communicates with the 5400 Fragment 
Analyzer computer via a serial communications port using the following serial 
port settings:

TCP/IP Port Communication

The host robotic sample handler system communicates with the 5400 Fragment 
Analyzer computer via a TCP/IP communications port using the following 
settings: 

As the system requires Administrator level login access to set the IP address, the 
5400 Fragment Analyzer computer should be setup with a static IP address.

Baud Rate 9600
Data bits 8
Parity None
Stop bits 1
Flow Control None

IP Address Use the 5400 Fragment Analyzer computer’s IP address
Port Number 3000 (Recommended)
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5400 Fragment Analyzer Automation Set-Up

Configure the system for automated operation 

1 Open the Fragment Analyzer software.
2 Navigate to Configuration > Device Settings in the Administrator drop-down 

menu.
3 Ensure that the instrument type listed is the 5400 Fragment Analyzer. If 

necessary, change to this type and confirm that the serial number matches 
the instrument sticker.

4 If you changed the instrument type:
a Save any changes.
b Close and re-open the software.

5 From the Administration menu, select Configuration.

The Configuration Settings window will open (Figure 108).
6 Select the Automation tab.

Figure 108 5400 Fragment Analyzer Automation configuration menu
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7 To enable serial port communication, select Remote serial automation enabled 
and ensure the parameters are set to those specified in section “5400 
Fragment Analyzer Communication Specifications” on page 161, and shown 
in Figure 108. 

8 Select the appropriate Com port (usually Com1). 

NOTE
The following Com ports should not be used as they are preassigned on the 
5400 Fragment Analyzer system:
• Com3 (High Voltage)
• Com4 (Pressure Transducer) 
• Com5 (Pump); Com6 (Stage)

9 If using TCP, select Remote TCP automation enabled and set the computer to 
use a static IP address, as dynamic IP addresses may not allow for consistent 
communication with the 5400 Fragment Analyzer system.

10 To disable remote automation, select None. 

NOTE
Even with the serial automation or TCP automation enabled, the 5400 Fragment 
Analyzer may be used as a standalone system without a robotic interface (i.e., it 
can be used as a normal Fragment Analyzer instrument).

11 Once the appropriate settings have been entered, select Save to apply, and 
close the window.
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5400 Automation Commands and Error Messages

Commands in the absence of a robotic system may be tested using any one of 
several terminal emulator applications, such as Tera Term or Hercules.
• Tera Term: https://ttssh2.osdn.jp/index.html.en
• Hercules: http://www.hw-group.com/products/hercules/index_en.html

All commands are sent as ASCII text and terminated with a carriage return 
(ASCII  13) or a line feed (ASCII 10). The commands are not case sensitive. 

When the Fragment Analyzer receives a valid command, an acknowledge shall be 
returned that consists of an asterisk (*) followed by the recognized command. 
When a move command has been carried out, the Fragment Analyzer will return 
*COMPLETE. If the run command failed for any reason !4, Command failed will be 
returned.

The 5400 Fragment Analyzer application recognizes the following commands 
listed in Table 28.
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Table 28 5400 Fragment Analyzer commands

Command Function Example

STATUS Fetch the run status. The status may include 
the following: Ready, Running, and Error

Send: status
Receive: *STATUS: Ready

OUT Push the Sample Tray (Drawer 1) out. Send: out
Receive: *OUT
Receive: *COMPLETE
Note: The Fragment Analyzer will move the Sample Tray (Drawer 1) 
to the out position, provided it is not running when the command is 
received.

OUT# Push the selected tray out, where # is the tray 
number, numbered from top down:
1 = Buffer (Drawer B)
2 = Waste (Drawer W)
3 = Marker (Drawer M)
4 = Storage (Drawer S)
5 = Sample (Drawer 1)

Send: out1
Receive: *OUT1
Receive: *COMPLETE
Note: The Fragment Analyzer will move the Buffer Tray (Drawer B) to 
the out position, provided it is not running when the command is 
received.

STORE Move the Capillary Storage Solution tray 
(located in S Drawer) to the capillary array. 
Note: When not in use, the capillaries should 
always be docked against Capillary Storage 
Solution to prevent drying of the capillary tips. 

Send: store
Receive: *STORE
Receive: *COMPLETE
Note: The Fragment Analyzer will move the Storage tray to the 
capillary array. 

TRAY Specifies the tray name for the next run. Send: tray agilent0216A
Receive: *TRAY
Note: The Fragment Analyzer will set the tray name to agilent0216A 
and load sample names if a sample names .txt or .csv file is found 
for that tray name in the C:\AATI\Samples directory. For more 
information, refer to Chapter 11, “Fragment Analyzer – Sample 
Name Entry”.

RUN Run a specified Fragment Analyzer separation 
method. The run command must be followed 
by a space followed by the method name to 
be run.

Send: run DNF-930-33 - DNA 75-20000bp.mthds
Receive: *RUN
Receive: *COMPLETE
Note: The Fragment Analyzer will start running the DNF-930-33 
separation method. A valid separation method file must be present 
to run. 

CAL Run and create the specified Size Calibration 
(.scal) file in the ProSize data analysis 
program. The specified file will be written to 
the calibration folder.

Send: cal DNF-930-33 - DNA 75-20000bp.mthds, calfile.scal
Receive: *CAL
Receive: *COMPLETE
Note: The Fragment Analyzer will run the specified separation 
method and output the specified .scal file named calfile.scal.
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The 5400 Fragment Analyzer application will output the following error 
messages listed in Table 29.

Table 29 5400 Fragment Analyzer Error Handling Commands

LAD-FILE Use the specified Size Calibration (.scal) 
ladder file for subsequent runs.

Send: lad-file calfile.scal
Receive: *LAD-FILE
Note: The specified .scal file will be referenced for the size calibration 
ladder. Using a previously created size calibration file enables the use 
of all 96-wells in a sample plate for samples. The same separation 
method and run parameters should be used for the calibration and 
for subsequent sample plates to ensure valid sizing results. 

ABORT Used to abort a run. Send: abort
Receive: *ABORT: Running
Receive: !10, ABORTED: remote abort command
Note: The method may take a minute to abort.

Command Function Example

Command Description

!1, Invalid command The command received was not recognized.

!2, No method The run command was received with no method. 

!3, Method not found The run command specified a method that is not in the appropriate 
methods directory. 
Ensure the separation method is present in the
C:\Agilent\Methods\33cm directory when using a 33cm array, or in 
the 
C:\Agilent\Methods\55cm folder when using a 55cm array.

!4, Command failed A run command failed for some reason.

!5, Low solution A run command could not be run due to solution levels – insufficient 
gel or conditioning solution, or a full waste bottle. 

!6, Stage error The run failed due to a stage position error.

!7, Pump command error The run failed due to a pump position error.

!8, Pressure error The run failed due to a failure to build pressure during a pumping 
operation.

!9, Camera Connection error The run failed because a camera connection error was encountered.

!10, Other The run failed due some other error. An error message will 
accompany this.
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5400 Fragment Analyzer Simulation Mode

For testing and demonstration purposes, it is possible to simulate the typical 
functions of the 5400 Fragment Analyzer system in the absence of an installed 
capillary array and/or fluids pumped through the system. The software enables 
simulation of individual components (for example, stage, pump, valves, etc.) or 
entire instrument operation. 

Enable the 5400 system for simulated operation

1 Open the Fragment Analyzer controller software and ensure the instrument 
type is listed as 5400 Fragment Analyzer.

2 From the Administration menu, select Configuration.

The Configuration Settings window will open.
3 Select the Simulate tab (Figure 109).

Figure 109 5400 Fragment Analyzer Simulate configuration menu
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4 To simulate the function of an individual component or components, select 
the check box next to the respective component(s) under Simulate Individual 
I/O. To enable simulation of all components, select Simulate all I/O. To 
simulate the camera, select Simulate camera box. The setting Pressure sensor 
uses the pump board is typically not selected, and only applies to older 
Fragment Analyzer instruments (Serial Number < 2600). 

In Figure 109, all individual components except the stage mechanism are 
simulated, enabling to test stage movement while simulating pumping and 
high voltage separation methods.

5 Press Save to apply your changes. 
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Example 5400 Fragment Analyzer Operation Sequence 

An example sequence of operations is listed below. A multitude of options can be 
programmed using the list of commands provided in Table 28.

Example Sequence for 5400 Fragment Analyzer, Automated Operation

1 Prepared Sample tray is ready (total about 2 seconds)
c Command to Fragment Analyzer API Status
d Message from Fragment Analyzer *STATUS: Ready GOTO Step 2
e Message from Fragment Analyzer *STATUS: Busy GOTO Step 1

2 Run the sample
a Command to Fragment Analyzer API Out (20-40 seconds)
b Message from Fragment Analyzer *Complete
c Robot places sample tray on stage drawer
d Command to Fragment Analyzer API RUN [METHOD NAME] 

(45 to 85 minutes depending on the method)

i. Pumping, voltage prerun, sample injection (20-25 minutes)
ii. Separation (typically 20 to 60 minutes)
iii. Data analysis and report generation 3 to 15 minutes (depends on report 
criteria)

e Message from Fragment Analyzer *Complete
f Command to Fragment Analyzer API Status
g Message from Fragment Analyzer *STATUS: Ready GOTO Step 2i
h Message from Fragment Analyzer !<error code> Notify operator, GOTO 

Step 2m
i Command to Fragment Analyzer API Out (20-40 seconds)
j Message from Fragment Analyzer *Complete
k Robot removes sample tray
l Another Sample? Yes: GOTO Step 2c; No: GOTO Step 2m
m Command to Fragment Analyzer API Store (20-40 seconds)
n Message from Fragment Analyzer *Complete
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5400 Fragment Analyzer Technical Support

For questions with the 5400 Fragment Analyzer system operation, contact your 
Agilent sales/service representative. 

NOTE
When working on integration with a robotics system, contact your Agilent 
support representative for the 5400 Fragment Analyzer drawer dimensions.

NOTE
Robotics integration is the sole responsibility of the customer and any 3rd party 
automation group contracted through the customer. For more information, 
contact your Agilent sales/service representative.
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